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Introduction

Qualified Persons

Review this
Instruction Sheet

Retain this
Instruction Sheet

Proper Application

Only qualified persons knowledgeable in the installation, operation, and maintenance
of overhead and underground electric distribution equipment, along with all
associated hazards, may install, operate, and maintain the equipment covered by this
publication. A qualified person is someone trained and competent in:

e The skills and techniques necessary to distinguish exposed live parts from
nonlive parts of electrical equipment

e The skills and techniques necessary to determine the proper approach distances
corresponding to the voltages to which the qualified person will be exposed

e The proper use of special precautionary techniques, personal protective
equipment, insulated and shielding materials, and insulated tools for working on
or near exposed energized parts of electrical equipment

These instructions are intended only for such qualified persons. They are not intended
to be a substitute for adequate training and experience in safety procedures for this
type of equipment.

Thoroughly and carefully read this instruction sheet before installing or operating
an IntelliRupter PulseCloser Fault Interrupter. Become familiar with the Safety
Information on page 3 and Safety Precautions on page 4. The latest version

of this publication is available online in PDF format at sandc.com/en/support/
product-literature/.

This instruction sheet is a permanent part of the IntelliRupter® fault interrupter. Designate
a location where users can easily retrieve and refer to this publication.

The equipment in this publication is only intended for a specific application. The
application must be within the ratings furnished for the equipment. Ratings for the
IntelliRupter fault interrupter are listed in the ratings table in S&C Specification
Bulletin 766-31.
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Safety Information

Understanding
Safety-Alert
Messages

Following Safety
Instructions

Replacement
Instructions
and Labels

Several types of safety-alert messages may appear throughout this instruction sheet and on
labels and tags attached to the product. Become familiar with these types of messages and
the importance of these various signal words:

A DANGER

“DANGER?” identifies the most serious and immediate hazards that will likely result in
serious personal injury or death if instructions, including recommended precautions,
are not followed.

“WARNING” identifies hazards or unsafe practices that can result in serious personal
injury or death if instructions, including recommended precautions, are not followed.

A CAUTION

“CAUTION” identifies hazards or unsafe practices that can result in minor personal
injury if instructions, including recommended precautions, are not followed.

“NOTICE” identifies important procedures or requirements that can result in product or
property damage if instructions are not followed.

If any portion of this instruction sheet is unclear and assistance is needed, contact the
nearest S&C Sales Office or S&C Authorized Distributor. Their telephone numbers are
listed on S&C’s website sandc.com, or call the S&C Global Support and Monitoring Center
at 1-888-762-1100.

Read this instruction sheet thoroughly and carefully before
installing the IntelliRupter fault interrupter.

If additional copies of this instruction sheet are required, contact the nearest S&C Sales
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be
replaced immediately. Replacement labels are available by contacting the nearest S&C
Sales Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.
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Safety Precautions

A DANGER

and rules.

IntelliRupter PulseCloser Fault Interrupters operate at high voltage. Failure to
observe the precautions below will result in serious personal injury or death.

Some of these precautions may differ from your company’s operating procedures
and rules. Where a discrepancy exists, follow your company’s operating procedures

QUALIFIED PERSONS. Access to an
IntelliRupter fault interrupter must be restricted
only to qualified persons. See the “Qualified
Persons” section on page 2.

SAFETY PROCEDURES. Always follow safe
operating procedures and rules.

PERSONAL PROTECTIVE EQUIPMENT. Always
use suitable protective equipment, such as rubber
gloves, rubber mats, hard hats, safety glasses,
and flash clothing, in accordance with safe
operating procedures and rules.

SAFETY LABELS. Do not remove or obscure
any of the “DANGER,” “WARNING,” “CAUTION,”
or “NOTICE” labels.

OPERATING MECHANISM AND BASE.
IntelliRupter fault interrupters contain fast-moving
parts that can severely injure fingers. Do not
remove or disassemble operating mechanisms or
remove access panels on the IntelliRupter fault
interrupter base unless directed to do so by

S&C Electric Company.

ENERGIZED COMPONENTS. Always consider
all parts live until de-energized, tested, and
grounded. The integrated power module contains
components that can retain a voltage charge for
many days after the IntelliRupter fault interrupter
has been de-energized and can derive a static
charge when in close proximity to a high-voltage
source. Voltage levels can be as high as the
peak line-to-ground voltage last applied to the
unit. Units energized or installed near energized
lines should be considered live until tested and
grounded.

GROUNDING. The IntelliRupter fault interrupter
base must be connected to a suitable earth
ground at the base of the utility pole, or to a
suitable building ground for testing, before
energizing an IntelliRupter fault interrupter, and at
all times when energized.

The ground wire(s) must be bonded to the system
neutral, if present. If the system neutral is not
present, proper precautions must be taken to
ensure the local earth ground, or building ground,
cannot be severed or removed.

VACUUM INTERRUPTER POSITION. Always
confirm the Open/Close position of each
interrupter by visually observing its indicator.

Interrupters, terminal pads, and disconnect
blades on disconnect-style models may be
energized from either side of the IntelliRupter fault
interrupter.

Interrupters, terminal pads, and disconnect

blades on disconnect-style models may be
energized with the interrupters in any position.

MAINTAINING PROPER CLEARANCE. Always
maintain proper clearance from energized
components.
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Overview

These instructions cover procedures for troubleshooting an IntelliRupter fault inter-
rupter on-site and remotely. IntelliRupter fault interrupters can be accessed for diagnosis
several ways:

Visually, on-site. Status of an IntelliRupter fault interrupter can be determined by
observing the STATUS indicator (white LED display), HOT LINE TAG indicator (amber
LED display), and positions of the interrupter OPEN/CLOSE/READY lever, HOT LINE
TAG lever, and, if applicable, the DISCONNECT operating lever.

Through secure Wi-Fi connection, on-site. Using IntelliLink® Setup Software
running on a laptop computer, connect to the IntelliRupter fault interrupter and
access the various configuration screens the Operation screen, and download histor-
ical data. Logged events are configured on the Logs>Log Management screen and
saved in memory. The Data log is viewed on the Logs>Historic Events screen. Logs
are automatically maintained for status points, special event counters, and system
startup history.

Through SCADA, remotely. The IntelliRupter fault interrupter fully supports DNP
3.0 protocol. If the communication and control module has been furnished with a
suitable radio, all DNP points are available through SCADA. Further, when Intelli-
Link® Setup Software has been furnished, the IntelliRupter fault interrupter and other
S&C automation products that communicate using DNP 3.0 protocol can be accessed
from any computer connected to the DNP network. Any member of the Intelli-

Team® SG Automatic Restoration System can also be accessed.

This instruction sheet is used with software version IntelliRupterECInstaller-7.6.x.exe.

The “x” can indicate any number from 0 to 255. Other related software component version
information is found on the Setup>General>Revisions screen. IntelliRupterECInstall-
er-7.6.x.exe is the name of the installer file available at the S&C Automation Customer
Support portal.

NOTICE

If the suggested diagnostic procedures do not resolve the problem, call the S&C
Global Support and Monitoring Center at 1-888-762-1100.

NOTICE

If possible, call the S&C Global Support and Monitoring Center for support before
removing an IntelliRupter fault interrupter from service. Do not swap control modules
to troubleshoot unless explicitly advised to do so in this document or by S&C
personnel.
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Overview

A WARNING

These instructions do not replace the need for utility operation standards. Any
conflict between the information in this document and utility practices should be
reviewed by appropriate utility personnel and a decision made as to the correct
procedures to follow.

The IntelliRupter fault interrupter is connected to high voltage. For this reason,
access should be treated with the same safety precautions that would be applied
when accessing other high-voltage lines and equipment. Follow all locally approved
safety procedures when working on or around the device.

Before attempting to access an existing switch installation, check carefully for
visible or audible signs of electrical or physical malfunction (do this before touching
or operating the switch control or any other part of the installation). These warning
signs include such things as smoke, fire, open fuses, crackling noises, loud buzzing,
etc. If a malfunction is suspected, treat all components of the installation, including
the switch control and associated mounting hardware, as if they were elevated to
primary (high) voltage.

Whenever manually reconfiguring the circuit (for example, during repairs), follow
your company’s operating procedures to disable automatic operation of the
IntelliTeam SG Automatic Restoration System. This prevents any unexpected
operation of a team member.

The IntelliTeam SG Automatic Restoration System can be disabled by selecting the
Prohibit Restoration state in any team member of the team to be disabled.
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Operating Levers and Indicators

The STATUS indicator, located on the underside of the IntelliRupter fault interrupter base,
on the face of the protection and control module, indicates operational status. The white
LED is visible up to 30 degrees from the center line of the base. See Figure 1.

When the IntelliRupter fault interrupter is powered, the indicator is on continuously
for 10 seconds. When all conditions are normal it then starts flashing for a %2 second every
30 seconds.

When a Wi-Fi connection to a local laptop computer is in progress, the indicator
pulsates dim to bright. When the Wi-Fi connection is terminated, the indicator is again on
continuously for 10 seconds and then starts flashing for a /4 second every 30 seconds.

CONTROL MODULE

Indicator .
Indicator

Figure 1. The STATUS and HOT LINE TAG indicators, located on the face of the protection
and control module.

If the interrupter OPEN/CLOSE/READY lever is moved (from Ready to Open, Ready
to Close, or the Open to Ready state), or the GROUND TRIP BLOCK lever is moved (from
the Removed to Set or from Set to Removed state), the indicator is again on continu-
ously for 10 seconds and then starts flashing for a %4 second every 30 seconds.

If any Error state is active or a Settings Mismatch state is active, the indicator
flashes on for a Y2 second every second.

When the STATUS indicator is off:
e If the line is not energized, energize the side with the integral power module.
e Ifthe line is energized, view the active Error conditions on the IntelliLink Software

Diagnostics>Error Diagnostics screen. Clear the Error conditions, or replace the
protection and control module.
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Operating Levers and Indicators

HOT LINE TAG
Indicator

Interrupter
OPEN/CLOSE/
READY Lever

When the STATUS indicator does not indicate a Wi-Fi connection

e If the line is energized, move the computer at least 20 feet closer to the fault
interrupter.

e Make sure the Wi-Fi connection was not inadvertently made to a different IntelliRupter
fault interrupter or it made a connection without the appropriate security keys.

e Try another computer furnished with IntelliLink Setup Software and appropriate
security keys.

e Replace the communication module.

The HOT LINE TAG indicator, located on the underside of the IntelliRupter fault inter-
rupter base on the face of the protection and control module, indicates Hot Line Tag
status. The amber LED is visible up to 30 degrees from the center line of the base. See
Figure 1 on page 7.

When a Hot Line Tag mode has been applied, either manually using the HOT LINE
TAG lever or electronically by Wi-Fi connection or SCADA, the indicator flashes for a
% second every 30 seconds.

When the Hot Line Tag mode has been removed, the indicator is off.

READY. In the Ready position, the left and right sections of the interrupter OPEN/CLOSE/
READY lever are in the upper position. The IntelliRupter fault interrupter uses the config-
ured General profile. See Figure 2 on page 9 and Figure 3 on page 9.

OPEN (and LOCK-OPEN). When the right section of the interrupter OPEN/CLOSE/
READY lever is moved to this position, the three interrupter actuators are mechanically
opened. A mechanical block is inserted into each actuator mechanism that prevents
closing, even if a malfunction causes the actuator closing coil to be energized. The lever
can be tagged or padlocked in the Open position. Moving the lever back to the Ready
position removes the mechanical block from the actuators.

CLOSE. When the left section of the interrupter OPEN/CLOSE/READY lever is moved
to this position, the IntelliRupter fault interrupter uses the Closing profile to electrically
close the interrupters. This is a momentary contact; a spring forces the lever to return to
the Ready position when the lever is released.
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Operating Levers and Indicators

Ready position

Interrupters open and
mechanically blocked
from closing

Momentary command
to electrically close

Interrupters open and
locked, mechanically
blocked from closing

Lockout/Tagout
device

Figure 3. IntelliRupter fault interrupter locked open.
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Operating Levers and Indicators

Manual Hot
Line Tag

Manual Ground Trip
Block (if furnished)

The Hot Line Tag mode can be applied manually using the hookstick lever, by an Intelli-
Link software command, or by a SCADA command. The Hot Line Tag mode is normally
removed using the same method by which it was applied; however, the HOT LINE TAG
lever can be used to remove electronically set tags as well. This procedure satisfies NESC
442E requirements, which allow local removal of an electronically set Hot Line Tag mode
when local indication of the electronic tag is provided. A Hot Line Tag mode will only be
cleared when all command types have been cleared.

The hookstick lever mechanically sets or clears its Hot Line Tag mode and can
be tagged or locked using conventional tagging procedures. See Figure 4 and Figure 5
on page 11.

When the HOT LINE TAG indicator is on the Hot Line Tag mode should be cleared:
o Ifa hot line tag was applied manually: Push up on the HOT LINE TAG lever.

e Ifa hot line tag was applied electronically and a hot line tag was applied
manually: Push up on the HOT LINE TAG lever. Then, pull down and push up on the
HOT LINE TAG lever once, without delay.

e Ifa hot line tag was applied electronically and a hot line tag was not
applied manually: Pull down and push up on the HOT LINE TAG lever twice,
without delay.

] "\ Pull down with a hookstick to
|_ manually apply Hot Line Tag

mode

Figure 4. Manually applying the Hot Line Tag mode.

The Ground Trip Block mode can be set locally with the GROUND TRIP BLOCK lever or
remotely using a SCADA or an IntelliLink software command. A Ground Trip Block mode
can only be removed by the method used to set it, and (unlike the HOT LINE TAG lever)
the GROUND TRIP BLOCK lever cannot remove a Ground Trip Block mode set by a
SCADA or IntelliLink software command.

To apply a local Ground Trip Block mode, pull down on the GROUND TRIP BLOCK
lever. It can be tagged using a tag or other conventional method. See Figure 4 and Figure 5
on page 11. To remove a local Ground Trip Block mode, push up on the GROUND TRIP
BLOCK lever. The STATUS indicator (white LED display) is located on the control module.
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Operating Levers and Indicators

See Figure 1 on page 7. When a Ground Trip Block mode is either set or removed, the
STATUS indicator will light at 100% brightness for 10 seconds to indicate the GROUND
TRIP BLOCK lever command has been received.

Hot Line Tag mode manually
applied and tagged

GROUND
TRIP
BLOCK

Figure 5. Hot line tag mode applied and tagged.

When Ground Trip Block mode is removed—Overcurrent protection operates
normally. If a Ground-Overcurrent element is configured for the active profile, then it
will respond to a Fault event. When a Ground-Overcurrent element is not configured in
the active profile, removing the Ground Trip Block mode does not create a ground TCC
nor does it enable the element.

When Ground Trip Block mode is set—Enabling the Ground Trip Block mode
will immediately disable and reset all selected elements, even when they were timing for
a fault when the lever was moved. The GROUND TRIP BLOCK lever is effective for any
profile: all General profiles, both Closing profiles, and Hot Line Tag mode.

The elements available for selection are: Ground, Negative Sequence, and Sensi-
tive Earth Overcurrent. When the GROUND TRIP BLOCK lever is configured to block
circuit testing, circuit testing immediately terminates.

If the test sequence was in the middle of an open interval when circuit testing was
terminated, the sequence will immediately go to the Lockout state. If the test sequence
was not in an open interval when the test sequence was terminated, the next trip will result
in a Lockout state.

If the GROUND TRIP BLOCK lever is configured for an alternate General profile,
the designated General profile becomes the active profile unless the unit is testing. If the
unit is testing the alternate General profile does not become active until the active test
sequence has completed.

Closing profiles and Hot Line Tag profiles are not affected by the position of the
GROUND TRIP BLOCK lever. SCADA or IntelliLink software commands to change the
General profile while using the Alternate profile are accepted, but the IntelliRupter fault
interrupter will not revert to the commanded General profile until the GROUND TRIP
BLOCK lever has been returned to the Unblocked position.
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Operating Levers and Indicators

DISCONNECT The hookstick-operated three-pole DISCONNECT lever on disconnect-style models cannot
operating Lever be operated until the interrupters have been opened. See Figure 6.

The interrupters can be closed and opened with the disconnect in the Open position.

Pull down with a
hookstick to close
disconnect

Pull down with a
hookstick to open
disconnect

Disconnect can be
tagged or locked in
the open position

Figure 6. The DISCONNECT operating lever locked open.
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Operating Levers and Indicators

Interrupter OPEN/ An OPEN/CLOSED indicator is provided for each interrupter on the underside of the Intel-
CLOSED Indicators liRupter fault interrupter base. See Figure 7.

When an interrupter is in the Open position, its indicator shows “O” on a green
background. When an interrupter is in the Closed position, its indicator shows “I” on a red
background. The reflective indicators are easily visible in low light; at night they can be
checked from the ground with a flashlight.

Target colors are reversed on IntelliRupter fault interrupters furnished with catalog
number suffix “-F2.

Indicator showing
pole open

Indicator showing

: pole closed
L B

Figure 7. The interrupter OPEN/CLOSED indicator, one at each pole.
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Troubleshooting with SCADA

DNP points are mapped to conform to SCADA system requirements. Refer to S&C Instruc-
tion Sheet 766-530, “IntelliRupter® PulseCloser® Fault Interrupter: Protection and
Communication Setup Instructions” and S&C Instruction Sheet 766-560, “IntelliRupter®
PulseCloser® Fault Interrupter: DNP Points List and Implementation.”

DNP points include:

e DNP Status Points. These points indicate that conditions are true or active. Status
points include interrupter Open or Closed state, active profiles, Hot Line Tag
state, Ground Trip Block state, and Circuit Test Block state. Also, the status of
protection elements and the IntelliTeam® SG Automatic Restoration System Alarm,
Warning, and Error states.

e DNP Analog Input Points. These points measure circuit parameters such as voltage,
current, frequency, harmonic distortion, power factor, kvars, phase angle, fault
current, etc. Site temperature and battery voltage are also reported.

o DNP Analog Output Points. These points are sent from SCADA and define specific
analog settings for the IntelliRupter fault interrupter.

e DNP Control Points. These points issue operation commands; they allow selec-
tion of the General and Closing profiles as well as the Hot Line Tag, Prohibit
Restoration, Block Ground Trip, and Block Circuit Testing modes. Waveform
Capture, Clear Errors, and Start a Battery Test commands can also be issued.

14
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Troubleshooting Capacitor and IPM Issues

Follow these steps for an IntelliRupter fault interrupter that is not operational but has
been previously commissioned as operational:

STEP 1. Attempt to connect to the unit with both SCADA and Wi-Fi.

STEP 2. Ifconnections cannotbe made, verify line voltage is being supplied to at least one
integral power module.

STEP 3. If power is present, verify the status light is not active/blinking. Typically, this
light blinks once every 30 seconds.

When unable to connect, power is present, and the status light is not active, no further
troubleshooting is required. Contact the S&C Global Support and Monitoring Center to
obtain a Return Material Authorization.

Capacitor These troubleshooting screens show possible IntelliRupter fault interrupter status

Verification points and indications that may be associated with an issue with the primary or secondary
capacitor banks. All points or combination of points may not be present at any given time,
but the presence of any of these may indicate a capacitor bank is the problem.

NOTICE

DO NOT remove or replace control modules on IntelliRupter fault interrupters
purchased before 2017 (serial number 08-0013000 and lower). Controls purchased
before 2017 may not connect when power is present and the status light is not
active. DO NOT troubleshoot the control by removing it and moving it to another
IntelliRupter fault interrupter. The pre-2017 control will cause damage to the fault
interrupter.

If the IntelliRupter fault interrupter was purchased after 2017 (serial number
08-0013001 and higher), it is acceptable to troubleshoot capacitor related issues
(alarms, warnings, and errors) by swapping the control into another IntelliRupter
fault interrupter.

If a capacitor bank is the problem, contact the S&C Global Support and Monitoring
Center at 1-888-762-1100. See Figures 8 and 9 on page 16, Figures 10 and 11 on page 17.
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Troubleshooting Capacitor and IPM Issues

File | Connection Data Tooks  Help
Wy g Valdale o Apply = Reset
InteliRupter®
PulseClaser

Cperation

IntelliTeam SG

Setup.

A Conlrol Bus Power Vollage 1wy {Range 10.00-24 00}
wl’.“:ommunbarion Tests | || pain Energy Cap Bank Voltage 432V (Range: 400-450)
s

Secondary Energy Cap Bank Voltage 433V (Range: £00-450)
Temperature 95F  35'C
Batlary Syslem State Disconnected
Battery Charger OK
Battery Vioilage D88V
Battery \Vollage without Surface Charge  0.00 Y
Batlery Impedance 0.000 ohms
Prodictod Minimum Voitage Under Load 0,00V
Battery Voltage Low’ Setpoint nANnv
Batlery Vollage 'Bad' Selpoint 1072v

File Connection Data Tools Help

L REEy [ Valdate o Apply % Reset |
IntelliRupter® || Connectedto: IR Location: Street Address Settings Applied Successfully
8| Fault Interrupter | T
Operation | Counters | Control Power | Comm | Port C: ications | Etheret | Tesis Wamings | Errors |

IntelliTeam SG (=R =R
I Setup
Metering Status Descripti Active Total Count Time Active [ Time Cleared
Diagnostics Application Board Calibration Data Invalid ]
Communication Tests CCP Board Calibration Data Invalid
Logs CFM: Serious Disk Problem

CF Disk Tampered Indication

Last Settings Backup UnSuccess

Last Settings Restore UnSuccess

BMM Mech. Data Read Problem

BMM Mech. Data Save Problem

BMM Calibr. Data Read Problem

Mechanism Alarm

Excessive Overtravel

Capacitor charge disabled alarm L]
Primary temp sensor issue

ATXRun timeout

Control Calibration Data Issue

Phase Rotation Indeterminate Alarm

Total Capacity is below 80 % L]
WiFi Intrusion Active

Log Flooding

S~ 00D O0DODODODO0OOO0D 0oL OO

11/11/2016 12:45:44 838 11/11/2016 13:40:04.659

lLoop_Restoration_Open_Ready._38KkVoxdss | Auto, at 1000ms. | 21315 BM

Figure 9. The Diagnostics>Alarms screen tab. The active capacitor alarm points will be
indicated in red.

For a description of these alarms, see the “Alarms” section on page 48.
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Troubleshooting Capacitor and IPM Issues

Connection Data Tools.

IntelliRupter® |
Fault Interrupter |

QOperation
IntelliTeam SG

I Setup

Metering
Diagnostics
Communication Tests
Logs

Help

Connected to: IR Location:  Streat Address

o |

| w validate ' Apply & Reset

Settings Applied Successfully.

Gounters | Control Power | Comm | Port Communications | Ethemet | Tests | Alarms [T erors |

Last Clear Time  11/16/2016 13-37-15.000

Active [Total Count

Time Active |

Time Cleared

Charger Overvoltage

Battery Low

BMM Is Not Ready

Nenfunctional [PM

Battery Bad

Warning - Secondary Not Opening

No Encoder Reset

No Contact Touch

Pulse Contact Touch Qut of Range 3 times
Close Contact Touch Out of Range 3 times
Current Profile incorrect

Remaining Contact Wear Low

Bad Voltage Sensor

No Encoder Output

BMS:Impedance Status

Capacitor charge disabled L)
Secondary temp sensor issue
Slow capacitor charge

Cap banks interconnect issue
Main Cap Bank Low

Unequal cap voltages
SEEPROM Issue

Sleep Time Indeterminate
Total Capacity is below 50 % L]
DPR: Prot. Presr No Respense

BMM: Settings Mismatch

Excessive Bounce

Mechanism Warning

0

e - -

11/11/2016 12:44:45.752 11/11/2016 13:32:19.751
11/11/2016 12:44:46.058  11/16/2016 13:37:16.050
11/11/2016 12:44:46.058 11/16/2016 13:37:16.050

Loop_Restoration Open_Ready_28KV.xdss | Auto, at 1000ms. | 216

Figure 11. The Diagnostics>Warnings screen.

For a description of these warnings, see the “Warnings” section on page 52.

File Connection Data Tools Help

n ol el

‘ IntelliRuptes

B Fault Interrupte
Operation
IntelliTeam SG

1 Setup

Metering
Diagnostics
Communication Tests
Logs

Connected to: IR Location:  Street Address

| & Validate & Apply % Reset |

Settings Applied Successfully

(O] ———— e

| Counters | Control Power | Comm | Part Ci

|' Etharnat | Tests | Aiarms] ‘Warnings m

@ Erors

Last Reset Time

Status Description
Main Power Bus Low
P15 out of Range
PE out of Range
D3.3 out of Range
Ab out of Range
A15+ out of Range
A15- out of Range
ATX Error State
DSP Error Condition
Mechanism Error
Error - Position Incorrect
Error - Close Position Out of Range:
Error - Main Coil Current
Insufficient energy during operation
Cap Not Charging [ )
Power Down Sequencing Error
Sensor Calibration Data Issue

0

CcCoocooocoocococoOoOoO0O O

Aetive Totel Count Time Active Time Cleared

Loop_Restoration Open_ Ready 38kV.xdss | Auto, at 1000ms. | 219:22 PM |

Figure 10. The Diagnostics>Errors screen.

For a description of these errors, see the “Errors” section on page 59.
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Troubleshooting with IntelliLink® Setup Software

Start IntelliLink
Software

Operation

Using IntelliLink Setup Software, the status of an IntelliRupter fault interrupter, other
team members, and team operations can be checked and the cause of team problems
investigated. IntelliLink software is used on-site with a secure Wi-Fi link from the laptop
computer to a specific IntelliRupter fault interrupter. IntelliLink software can also be used
remotely, through a computer connected to the DNP network.

After the computer is configured and set up for Wi-Fi communication, connection is
automatically accomplished through the IntelliLink Setup Software.

To connect to an IntelliRupter fault interrupter with IntelliLink Setup Software, refer
to the “Wi-Fi Connection to an IntelliRupter Fault Interrupter with IntelliLink® Setup
Software” section in S&C Instruction Sheet 766-571, “IntelliRupter® PulseCloser® Fault
Interrupter: Software Installation.”

With software later than version 7.3.100, the default passwords for all user accounts,
including the Admin account, must be changed before the IntelliLink software

can connect to and configure a control. See S&C Instruction Sheet 766-530,
“IntelliRupter® PulseCloser® Fault Interrupter: Protection and Communication
Setup,” for more information.

After password verification, the Operation screen opens. It presents IntelliRupter
fault interrupter status information and is used to operate the device. See Figure 12
on page 19. User-assigned IntelliRupter fault interrupter identification information
(Connected to: and Location:) is shown at the top of every screen.
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Figure 12. The IntelliRupter fault interrupter Operation screen.

An electronic representation of the IntelliRupter fault interrupter OPEN/CLOSE/
READY lever side is shown in Figure 12. Poles 1, 2, and 3 are displayed left to right (in this
case labeled 1, 2, and 3). The upper terminal pads are labeled Y1, Y2, Y3, and the lower
terminal pads are labeled X1, X2, X3.

Phase-to-ground voltage at each terminal pad (for example, A-grd) or phase-to-phase
voltage at each terminal pad (for example, A-B) is shown on the associated pole-unit, and
the voltage units are user-assigned.

NOTICE

Because the IntelliRupter fault interrupter voltage sensors are high-impedance
sensing devices, they will indicate a presence of voltage on the Y side terminals
when the optional disconnect is installed and open. The voltage reading is an
artifact of leakage current resulting from parasitic capacitance. Therefore, the
readings can be quite variable from unit to unit and pole to pole. Humidity and other
weather related conditions add to the variability at a given unit.

Measured current at each pole-unit is displayed below the lower terminal pad voltage,
along with an arrow to indicate three-phase power-flow direction. Current is flowing from
the upper to the lower terminal pad when the arrow points right. Current is flowing from
the lower to upper terminal pad when the arrow points left.
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Current flow is determined by the three-phase directional power element, so all

arrows point the same way. Reported current is zero and directional arrows are not shown
when the IntelliRupter fault interrupter is in the Open state.

When the IntelliRupter fault interrupter trips open because of a fault, the status box at

each pole-unit will show more information:

TESTING—Displays when the IntelliRupter fault interrupter is in the Open state and
is still testing

TESTING-SEF—Display when the IntelliRupter fault interrupter is in the Open state
and is still testing for a sensitive earth fault

PICKUP—Display when one of the elements has exceeded its pickup value and is
timing to trip

Additionally,

—-0OC—Displays when timing began because of an Overcurrent condition
—-VOLTS—Displays when timing began because of a Voltage condition
-FREQ—Displays when timing began because of a Frequency condition

-G OC—Displays when timing began because of a Ground Overcurrent condition
-NSOC—Displays when timing began because of a Negative Sequence condition
—SECT—Displays when timing began because of a Sectionalizing condition
—SEF—Displays when timing began because of a Sensitive Earth Fault condition
LOCKED OPEN—Displays when the OPEN/CLOSE/READY lever is locked open

LOCKOUT—Displays when the IntelliRupter fault interrupter has completed testing
and has gone to the Lockout state

Additionally,

—PulseClosing—Displays when the test using PulseClosing® Technology issued a

fault condition and has gone to the Lockout state

—0OC—Displays when tripping was because of an Overcurrent condition
-VOLTS—Displays when tripping was because of a Voltage condition
-FREQ—Displays when tripping was because of a Frequency condition
—SECT—Displays when tripping was because of a Sectionalizing condition
—SEF—Displays when tripping was because of a Sensitive Earth Fault condition

Close Blkd-Sync Check—Displays when the IntelliRupter fault interrupter was
attempting to close, the Sync Check mode was in operation, and there was a differ-
ence in frequency between the X and Y sides that exceeded the settings in the closing
profile that resulted in the IntelliRupter fault interrupter not closing

Close Blkd Pulse Inop—Displays when the IntelliRupter fault interrupter was
attempting to close and did not, the PulseClosing Technology test was not available,
and the user setting for Conventional Close if PulseClosing Not Available was set
to “No.”

20
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e Close Blkd No Energy—Displays when the IntelliRupter fault interrupter was
attempting to close and did not because of insufficient storage-capacitor energy

o Fault-PulseClosing—Displays when the IntelliRupter fault interrupter has completed
the test using PulseClosing Technology and has gone to the Lockout state

o SETTINGS MISMATCH—Displays when the settings in the control module are
incompatible with the settings in the base memory module, no settings are active and
protection and restoration functions are not active (This can happen when a control
module with an updated setpoint file is placed into an IntelliRupter fault interrupter
base that previously had an older, incompatible setpoint file in the base memory.
Issuing the Apply Settings command will remove this condition, and the previous
settings stored in the base memory module will be overwritten and lost.)

When the Lockout state was caused by an Overcurrent condition, the current occur-
ring at each pole-unit at the time of the initial trip will be shown. A Fault flag in the form
of a red lightning bolt will be shown at the pole-unit(s), at which Overcurrent condition
was sensed by the phase element to indicate the direction of the fault. The Fault flags are
also available as DNP Status Points that are described in S&C Instruction Sheet 766-560,
“IntelliRupter® PulseCloser® Fault Interrupter: DNP Points List and Implementation.”

The Fault flag is set in response to an Overcurrent event, for any phase that has timed
beyond 20% of trip when an Overcurrent element has tripped, or for any phase that was
timing when a Ground-Overcurrent element tripped. When a Ground-Overcurrent
element trips and none of the phases are picked up, a Fault flag is set for each phase.

Control status will normally show “Okay.” If a problem exists, Alarm, Warning,
Error, or Maint Mode will be displayed. If Alarm, Warning, or Error mode is displayed,
navigate to the applicable diagnostics screen to view the active conditions.

MAINT MODE (Maintenance mode) indicates one or more of the application
programs have suspended. Restarting the control or reloading the control code are
typical remedies for this condition. If the condition persists after attempting these
remedies, contact the S&C Global Support and Monitoring Center at (888) 762-1100.

When Hot Line Tag mode is applied, it will be indicated by “On,” and the method of
application is displayed. The active profile and other features are indicated on this screen.
See the “Operation Screen” section in S&C Instruction Sheet 766-540, “IntelliRupter®
PulseCloser® Fault Interrupter: Operation.”
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Metering

B SEC Imeinlink Setup Software [605.5] =il Hof B3
File  Connection Data Toolks  Help
IR 4 & W Validate & Apply 5 Reset
5! InteRupter® wh COG16  Location: HWY 43 JUST NORTH OF CELESTE RD Seltngs Reset
L e T ] e
Open Primary Metenng Data
IntelToam SG RMS Values Par-Phase
4 Setup
General gy (MWh)
4 Profoction A-SideVolage  ¥-SideVoRage  Curremt  PowsrFactor  Powsr  Reactive Powsr
Ganeral Profile 1 | Direc? Direct
Ganars! Frodie 2 A 32266V NV DA 1.000 0 kW 0 KVAR 0 kW 0 kW
Goneral Profils 3
General Profile 4 B 1246V 2265V oA 1.000 0 kW O kvAR 0 kW OkwW
Hot Line Tag
Clsing Profia 1 c 24TV 2344V 0A 1.000 0RW 0 KVAR okw oKW
Clasing Profie 2 g
ol Lial P 3-Phase Totals 0kW 0 KVAR 0kW kW
Advanced Setup Vollage Reporting Phasa to Ground MY
4 Restoration w
InteliTeam SG System Frequency  0.00 Hz
= o i Current Direction
Foint Mapping Sys Phase Rotation 123
Securty
\op Mataring Data
mﬂg - X $ide Voltage ¥-Side Voltage: Corrents
Logs Residusl Neg Pos Residual Heg Pos Residusl Neg Pos
010V [T TRY [TIRY (RTRY oMy oMy DA 0A 04
Power Harmonic Data % Total Harmonic Distortion
B X-$ide Voltage ¥-5ide Voltage Current
. A TEIT % 7937 % 00%
EC B 7937 % 793.7 % 0.0%
[+ THIT % 7937 % 00%
Snapshot: C:\Lisersirob. thomasiDetktoplIR 3.5, 1.vm | Refresh Mode: Auto, at 1000ms. | Rofrosh: 1:18:34 PM Refresh: Stop. RAW

Figure 13. The Metering screen.

All values are time-averaged, reported locally and via SCADA on a one-second interval. See
Figure 13.

Primary Metering Data

X-Side and Y-Side Voltage

True RMS values of phase voltages in volts are reported. Either Phase-Ground or Phase-
Phase measurement may be selected, as configured with the Voltage Reporting setpoint
on the Setup>General>Site-Related>System screen.

Current

True RMS values of phase current in amperes are reported. Fundamental (phasor) deriva-
tives are calculated for the residual current.

Power Factor

True per-phase power factor, based on the X-side voltages, is displayed in kilowatts. Power
factor is calculated as the cosine of the corrected phase angle. The leading power factor is
represented by a negative number.

Power
True per-phase and three-phase total power in kW are based on X-side phase voltages.
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Reactive Power
Measured reactive power is displayed in kvars and is based on X-side phase voltages.

Energy

Phase energy and three-phase total energy, in total kilowatt hours, accumulated since the
last Reset MWh command, are based on X-side and Y-side phase voltages.

Reset MWh
Click on the Reset MWh button to reset all energy readings to zero.

Voltage Reporting
System-voltage measurements are displayed as either phase to phase, or phase to ground.

System Frequency
Measured system frequency is displayed in Hertz.

Delta Frequency

The measured system-frequency difference between the X and Y sides of an open
IntelliRupter fault interrupter is displayed in Hertz.

Current Direction
This indicates the direction of current flow, either Direction 1 or Direction 2.

System Phase Rotation
This indicates the detected system phase rotation as 123, 132, or Indeterminate.

Secondary Metering Data

Residual-, negative-, and positive-sequence components are calculated for X-side voltage,
Y-side voltage, and current. Voltage sequence components are derived by summing the
product of the VAB and VCB inputs, with the latter multiplied by a unit vector having either
+120° (positive sequence) or —120° (negative sequence) phase angle.

The sum is equal to V phase-ground (positive sequence) when configured for
phase-to-ground reporting or V phase-to-phase (positive sequence) when configured for
phase-to-phase reporting. Negative sequence voltage and current are nominally zero in a
balanced system.

Power Harmonic Data
Use the Calculation Method: button to select the desired calculation method.
Total Harmonic Distortion is defined by the formula where:

Xi = the amplitude of the nth harmonic of voltage or current and XI = the amplitude
of the fundamental of voltage or current.

THD is actually computed using the true RMS and fundamental RMS voltage and
current values developed by the IntelliRupter fault interrupter, using the formula where:

RMSTrue = True RMS of the current or voltage, and RMSFund= Fundamental (1st
Harmonic) RMS of the current or voltage.
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Figure 14. The Metering-Sync Check screen.

All values are time-averaged and are reported locally on a one-second interval. See
Figure 14.

Sync-Check Metering Data

Voltage

Terminal X and terminal Y positive-sequence RMS voltages are displayed either on a phase-
to-phase basis (for example, A-B) or on a phase-to-ground basis (for example, A-gnd), as
configured on the Setup>General>Site Related>System>Voltage Reporting screen. The
voltage values are determined by the Voltage Reporting Base setpoint on the Setup>-
General>Site Related>System>Voltage Reporting Base screen and are reported with a
0.01-unit resolution.

When three-phase voltage is applied to both terminal X and terminal Y, voltage (as
defined above) may initially be measured as negative-sequence voltage. However, if the
phase rotation is equal for both terminal X and terminal Y. Regardless of whether they
match the Phase Rotation setpoint on the Setup>General>Site Related>System>Phase
Rotation screen, these metering values will change to positive-sequence voltage in roughly
one minute. Therefore, it may take a minute or so for voltage values to appear in both the
terminal X and terminal Y voltage displays.

Conversely, if phase rotation is unequal, one terminal will be measuring positive-se-
quence voltage, and the other terminal will be measuring negative-sequence voltage. When
this occurs, the terminal measuring negative-sequence voltage will have no value in the
voltage display because the terminal X and terminal Y voltage displays only show posi-
tive-sequence voltage.
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Frequency

Terminal X- and terminal Y-measured system frequency is displayed in Hertz (Hz) with a
0.01-Hz resolution.

Phase Rotation

Terminal X and terminal Y phase rotation are displayed as “1 2 3,” “1 3 2,” or
“EUnknown®*,”

When the terminal X and terminal Y phase rotations are unequal (for example, X side
is “1 2 3” and Y side is “1 3 2"), both terminal X and terminal Y phase-rotation displays are
highlighted in red.

The X-side and Y-side phase rotations are displayed based on the predominance
of positive- or negative-sequence voltage. A predominance of positive- or negative-se-
quence voltage is defined as either the measured positive- or negative-sequence voltage
being greater than the percentage value entered for the active General Profile’s Good
Source Voltage Indication setpoint on the Setup>Protection>General Profile>Voltage,
Frequency, and Sectionalizing>Voltage Trip>Good Source Voltage Indication screen or
the configured System Phase-to-Phase Voltage setpoint on the Setup>General>
System>System Phase-to-Phase Vollage screen.

For example, the System Phase-to-Phase Voltage setpoint is 12.47 kV and the active
General Profile Good Source Voltage Indication setpoint is 90% (11.223 kV). When the
measured X-side positive-sequence voltage minus the X-side negative-sequence voltage is
greater than 11.223 kV, the X side has a predominance of positive-sequence voltage.

A predominance of positive-sequence voltage (X side or Y side) results in a phase-ro-
tation indication of “1 2 3,” and a predominance of negative-sequence voltage produces a
phase-rotation indication of “1 3 2.” However, if the phase rotation for both X and Y termi-
nals is equal, phase rotation for X and Y will always be displayed as “1 2 3.” This is because,
as with the voltage display, equal phase rotation always results in the measured voltage
being displayed as positive-sequence.

If a predominance of X-side or Y-side positive- or negative-sequence voltage (as
defined above) is not present, “**Unknown**” is displayed for the phase rotation.

For example, the System Phase-to-Phase Voltage setpoint is 12.47 kV and the active
General Profile Good Source Voltage Indication setpoint is 90% (11.223 kV). When the
measured X-side positive-sequence voltage minus the X-side negative-sequence voltage is
less than 11.223 kV, the X side has an “**Unknown**” phase rotation.

Phase Angle Difference

The phase-angle difference between the X side (pole no. 2) and the Y side (pole no. 2) is
displayed in degrees with polarity (plus or minus). A positive (plus) phase-angle difference
denotes the X-side (pole no. 2) voltage is leading the Y-side (pole no. 2) voltage, and a
negative (minus) phase-angle difference indicates the X side is lagging the Y side.

AC Synchrocheck Relay and LED 360-Degree Synchroscope

The 15 cells are oriented in a semicircle, and the top center cell represents 0 degrees. The
cells change color to show the phase-angle difference determination described above.

The seven cells to the left and below the top center cell are labeled “Slow,” with an
arrow pointing in a counterclockwise direction. The six cells to the left and below the top
center cell indicate lagging phase angles in 15-degree increments.

S&C Instruction Sheet 766-550 25



Troubleshooting with IntelliLink® Setup Software

The seven cells to the right and below the top center cell are labeled “Fast,” with an
arrow pointing in a clockwise direction. The six cells to the right and below the top center
cell denote leading phase angles in 15-degree increments.

The bottom left (Slow or lagging) and right (Fast or leading) cells represent phase
angles greater than 90 degrees and are colored red when the phase-angle difference
between the X side (pole no. 2) and Y side (pole no. 2) is lagging or leading by greater than
90 degrees.

The first six cells to the left (Slow) and right (Fast) of the top center cell are yellow
when the X side and Y side measured phase angle is +/-7 degrees of the cell-angle value.
The first cells to the left and right of the top center cell have a phase angle value of 15
degrees. The second cells to the left and right of the top center cell have a phase angle
value of 30 degrees, and so on.

The top-center (0 degree) cell turns green when the X side and Y side phase-angle
difference is 0 degrees, +/-7 degrees.

For example, if the phase-angle difference between the X side and Y side is between
37 degrees- and 23 degrees-leading, the second cell (30 degrees Fast) to the right of the
top-center cell will be yellow. Similarly, if the phase-angle difference is between 8 degrees-
and 22 degrees-lagging, the first cell (15 degrees Slow) to the left of the top-center cell will
be yellow.

The color of these phase-angle cells will typically transition clockwise (lagging to
leading) or counterclockwise (leading to lagging), based on the changing phase-angle
relationship between the X side and Y side. However, because all metering-screen values
are time-averaged and are reported locally on a one-second interval, the transition of cell
angles may sometimes appear erratic. As an example, if the rate-of-change of the phase-
angle difference is rapid because of appreciable frequency-differences between the X side
and Y side, the transition of cell color may skip cells due to the one-second screen-re-
fresh rate.

Single-Phase or Three-Phase Operation is Active

When the display indicates “**Single-Phase Operation is Active**” switch operations will
be single-phase and automatic operations will be single-phase when the test sequence is
configured for single-phase tripping. When the display indicates “**Three-Phase Opera-
tion is Active**” all automatic operations or IntelliLink software user commands will be
executed three-phase, and single-phase SCADA commands will be rejected.

Active General Profile

This displays the user-assigned name of the active general profile. It may be one of the four
general profiles. Change it by clicking on the Change drop-down selection button.

Active Closing Profile

This displays the user-assigned name of one of the two closing profiles. Change it by
clicking on the Change drop-down selection button.

ENABLE CLOSE OPERATION

This button commands a Close operation.

26
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Figure 15. The Diagnostics>Counters screen.

The counters show the number of Open, Close, and Pulse operations for each pole-unit
interrupter. See Figure 15.

Cumulative Counters

These counters indicate the percentage of remaining contact wear for each pole and
cannot be reset.

Resettable Counters
These counters can be reset to zero as a group with a Reset All button command.

Last Reset

This time stamp indicates the date and time the resettable counters received a Reset All
button command.
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Figure 16. The Diagnostics>Control Power screen.

The screen shows the status of system power, the battery system, and temperature of the
control module. See Figure 16.

Control Power

AC Power
Reports that control power is either “OK” or “Off.”

Control Bus Power Voltage
Reports in volts dc. (Range: 10.00-24.00)

Main Energy Cap Bank Voltage
Reports in volts dc. (Range: 400-450)

Secondary Energy Cap Bank Voltage
Reports in Volts dc. (Range: 400-450)

Temperature

Temperature is measured inside the control module and reports as whole degrees in Fahr-
enheit and Centigrade.
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Battery Power

Battery System State

The following states are reported: Normal, Battery Low, Battery Bad, Low Impedance,
Disconnected, or Testing.

Battery Charger

The following states are reported: OK, Over Voltage, Low Impedance, or Over Voltage
+ Low Impedance.

Battery Voltage
Reports to the nearest .01 Vdc.

Battery Voltage without Surface Charge
Reports to the nearest .01 Vdc.

Battery Impedance
Reports to the nearest .001 Ohm.

Predicted Minimum Voltage Under Load
This value is calculated during the battery test and reported to the nearest .01 Vdc.

Battery Voltage “Low” Setpoint

This is the factory-set value of the voltage threshold for reporting the Battery Voltage
Low status.

Battery Voltage “Bad” Setpoint

This is the factory-set value of the voltage threshold for reporting the Battery Voltage
Bad status.
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Figure 17. The Diagnostics>Comm screen.

Clear Button

This button clears all data on the Diagnostics>Comm screen and enters a time stamp in
the Last Time Cleared field. See Figure 17. These parameters are reported:

Last Time Cleared

This is the time stamp of the last Clear command. Recently cleared counters represent
present communication performance more accurately.

Real-Time DNP Peer-to-Peer (P2P) Communication Statistics

This report shows the counters and statistics associated with peer communication for
each team in which this control is a member.

DNP Address
This is the DNP/RTU address of the team member associated with the displayed counts.

Data Type

The Data Type setting is configured on the Setup>Communications>

Communication Tests screen. Possible values are: Undefined, General, Internal DNP,
Coach, Runner, Contract Agent, Netlist Transfer, Alley Oop RSH, IT-II Events,
Protection, Data Load Mgmt PRLM, CEC Signal, Diagnostics, or NetObjectMgmt.

Total Messages Sent
This is the number of original packets transmitted to the team member.
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Total Messages Received
This is the number of responses received from the team member.

Retry Count
This is the number of packets retransmitted to the team member.

Fail Count
This is the number of communication failures for the team member.

Daily DNP P2P Communication Statistics

The counters and statistics associated with daily peer communication for each team in
which this control is a member. These parameters are reported:

DNP Address
This is the DNP/RTU address of the team member associated with the displayed counts.

Data Type

The Data Type setting is configured on the Setup>Communications>Communication
Tests screen. Possible values are: Undefined, General, Internal DNP, Coach, Runner,
Contract Agent, Netlist Transfer, Alley Oop RSH, IT-II Events, Protection, Data
Load Mgmt PRLM, CEC Signal, Diagnostics, or NetObjectMgmt.

Total Messages Sent
This is the number of original packets transmitted to the team member.

Total Messages Received
This is the number of responses received from the team member.

Retry Count
This is the number of packets retransmitted to the team member.

Fail Count
This is the number of communication failures for the team member.

Last 2way
This is the latency, in seconds, associated with the last request sent to the team member.

Min 2way
This is the minimum latency, in seconds, recorded for a request sent to the team member.

Max 2way
This is the maximum latency, in seconds, recorded for a request sent to the team member.

Avg 2way
This is the average latency, in seconds, recorded for requests sent to the team member.

S&C Instruction Sheet 766-550 31



Diagnostics

Link Health Metric

This is the percentage of tests that had a response even if a retry was required. This is the
ACK'd XMit Count divided by the Total XMit Count.

Link Health
This shows a color indication for the link health metric:

Gray-Less than 100 transmissions have been sent.
Red-Bad; link health metric is less than 25%.
Yellow-Marginal; link health metric is 25% or greater and less than 95%.
Green-Good; link health metric is 95% or greater.
These threshold settings can be adjusted in the “Peer Communications Statistics

Configuration” section of the Setup>Communications>DNP Diagnostics screen.

Daily Worst Performing DNP P2P Link History

This report shows the counters and statistics associated with peer communication for the
worst performing link. These parameters are reported:

Time stamp
This is the time of the transmission.

DNP Address
This is the DNP/RTU address of the team member associated with the counts shown.

Data Type

The Data Type setting is configured on the Setup>Communications>

Communication Tests screen. Possible values are: Undefined, General, Internal DNP,
Coach, Runner, Contract Agent, Netlist Transfer, Alley Oop RSH, IT-II Events,
Protection, Data Load Mgmt PRLM, CEC Signal, Diagnostics, or NetObjectMgmt.

Total Messages Sent
This is the number of original packets transmitted to the team member.

Total Messages Received
This is the number of responses received from the team member.

Retry Count
This is the number of packets retransmitted to the team member.

Fail Count
This is the number of communication failures for the team member.

Last 2way
This is the latency (in seconds) associated with the last request sent to the team member.
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Min 2way
This is the minimum latency (in seconds) recorded for a request sent to the team member.

Max 2way
This is the maximum latency (in seconds) recorded for a request sent to the team member.

Avg 2way
This is the average latency (in seconds) recorded for requests sent to the team member.

Link Health Metric

This is the percentage of tests that had a response even if a retry was required. This is the
ACK'd XMit count divided by the Total XMit count.

Link Health
This shows a color indication for the link health metric:

Gray-Less than 100 transmissions have been sent.
Red-Bad; link health metric is less than 25%.
Yellow-Marginal; link health metric is 25% or greater and less than 95%.
Green-Good; link health metric is 95% or greater.
These threshold settings can be adjusted in the “Peer Communications Statistics

Configuration” section of the Setup>Communications>DNP Diagnostics screen.

DNP V3 Real-Time Communication Statistics

This report shows the counters and statistics associated with DNP communications. These
parameters are reported:

DNP Address
This is the DNP/RTU address of the team member associated with the counts shown.

Total Messages Sent
This is the number of original packets transmitted to the team member.

Retry Count
This is the number of packets retransmitted to the team member.

Fail Count
This is the number of communication failures for the team member.

Last 2way
This is the latency (in seconds) associated with the last request sent to the team member.

Min 2way
This is the minimum latency (in seconds) recorded for a request sent to the team member.
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Max 2way
This is the maximum latency (in seconds) recorded for a request sent to the team member.

Avg 2way
This is the average latency (in seconds) recorded for requests sent to the team member.

Daily DNP V3 Communication Statistics
This report shows the counters and statistics associated with DNP communications.

DNP Address
This is the DNP/RTU address of the team member associated with the counts shown.

Total Messages Sent
This is the number of original packets transmitted to the team member.

Retry Count
This is the number of packets retransmitted to the team member.

Fail Count
This is the number of communication failures for the team member.

Last 2way
This is the latency, in seconds, associated with the last request sent to the team member.

Min 2way
This is the minimum latency, in seconds, recorded for a request sent to the team member.

Max 2way
This is the maximum latency, in seconds, recorded for a request sent to the team member.

Avgd 2way
This is the average latency, in seconds, recorded for requests sent to the team member.

Link Health Metric

This is the percentage of tests that had a response even if a retry was required. This is the
ACK’d XMit count divided by the Total XMit count.

Link Health
This shows a color indication for the link health metric:

Gray-Less than 100 transmissions have been sent.

Red-Bad; link health metric is less than 25%.

Yellow-Marginal; link health metric is 25% or greater and less than 95%.
Green-Good; link health metric is 95% or greater.

These threshold settings can be adjusted in the “Peer Communications Statistics
Configuration” section of the Setup>Communications>DNP Diagnostics screen.
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Peer-SCADA Master Communication Statistics
These parameters are reported:

Master
This is the master station identifier.

DNP Address
This is the DNP address of the master station associated with the counts shown.

Total Messages Sent
This is the number of original packets transmitted to the team member.

Retry Count
This is the number of packets retransmitted to the team member.

Fail Count
This is the number of communications failures for the team member.

Last 2way
This is the latency (in seconds) associated with the last request sent to the team member.

Min 2way
This is the minimum latency (in seconds) recorded for a request sent to the team member.

Max 2way
This is the maximum latency (in seconds) recorded for a request sent to the team member.

Avgd 2way
This is the average latency (in seconds) recorded for requests sent to the team member.

Daily Worst Performing DNP V3 Link History

This report shows the counters and statistics associated with DNP communications. These
parameters are reported:

Time stamp
This is the time of the message transmission.

DNP Address
This is the DNP/RTU address of the team member associated with the counts shown.

Total Messages Sent
This is the number of original packets transmitted to the team member.
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Retry Count
This is the number of packets retransmitted to the team member.

Fail Count
This is the number of communications failures for the team member.

Last 2way
This is the latency, in seconds, associated with the last request sent to the team member.

Min 2way
This is the minimum latency, in seconds, recorded for a request sent to the team member.

Max 2way
This is the maximum latency, in seconds, recorded for a request sent to the team member.

Avg 2way
This is the average latency, in seconds, recorded for requests sent to the team member.

Link Health Metric

This is the percentage of tests that had a response even if a retry was required. This is the
ACK’d XMit count divided by the Total XMit count.

Link Health
This shows a color indication for the link health metric:

Gray-Less than 100 transmissions have been sent.

Red-Bad; link health metric is less than 25%.

Yellow-Marginal; link health metric is 25% or greater and less than 95%.
Green-Good; link health metric is 95% or greater.

These threshold settings can be adjusted in the “Peer Communications Statistics
Configuration” section of the Setup>Communications>DNP Diagnostics screen.
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DNP Counts

These are counts of diagnostic information for DNP communications-related buffers
within this control. These parameters are reported:

Transport Function Receive List

This is the number of DNP frames received and placed in the transport function frame
buffer. A frame may remain in the buffer if it is part of a multi-frame fragment for which
all frames have not been received. It may also remain in the buffer for a limited time if the
application layer is busy and cannot accept the new frame.

Transport Function Transmit List

This is the number of DNP fragments processed by the application layer and waiting for a
data link layer service. A fragment may remain in the buffer for a limited time if the data
link layer is busy.

Application Layer Message List

This is the number of application layer messages waiting to be processed or serviced

by the transport function, primarily consisting of originated messages to team members
for which responses are expected. The messages remain in the buffer until a response is
received or until the retry time and count have expired.

Peer Device List

This is the number of peer devices or team members registered with DNP for which an
association is maintained.

Special Function List

This is the number of application processes registered with DNP that will be triggered by
read or write operations to special predefined virtual memory locations.

URBE Function List

This is the number of functions or application processes registered with DNP that will be
triggered by unsolicited event messages from specific peer devices.

Binary Input Point List

This is the total number of binary input points that may be mapped to SCADA point
numbers. It is the size of the buffer, not the actual number of mapped points.

Double-Bit Binary Input Point List (Only for SG6801,
SG6802Vista, and SG68023PM)

This is the total number of double-bit binary input points that may be mapped to SCADA
point numbers. It is the size of the buffer, not the actual number of mapped points.

Analog Input Point List

This is the total number of analog input points that may be mapped to SCADA point
numbers. It is the size of the buffer, not the actual number of mapped points.
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Control Input Point List

This is the total number of control input points that may be mapped to SCADA point
numbers. It is the size of the buffer, not the actual number of mapped points.

Analog Output Point List

This is the total number of analog output points that may be mapped to SCADA point
numbers. It is the size of the buffer, not the actual number of mapped points.

Route Table List

This is the number of routing table entries registered with DNP. They originate from the
Setup>Communications Routing screen.

Master Event Counts

Binary Inputs

This is the number of binary input events queued and ready to be sent in the next event
data request or in the next unsolicited event report.

Analog Inputs

This is the number of analog input events queued and ready to be sent in the next event
data request or in the next unsolicited event report.
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Port Communications
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Figure 18. The Diagnostics>Port Communications screen.

IntelliTeam II/SG Communications
(Only for controls using the IntelliTeam II/SG Automatic Restoration System)

See Figure 18. These counters and statistics are associated with peer communications
for each team in which this control is a member:

Port
This is the port connected to the control.

TX/RX

This report indicates whether the packet was transmitted or received.

Src/Dest

This is the destination address for a transmitted message and the source address for a
received message.

Protocol
The protocol is only peer-to-peer and is reported as “DNPP2P.”

Data Type

This report notes the message type as: Undefined, General, Internal DNP, Coach,
Runner, Contract Agent, Netlist Transfer, Alley Oop RSH, IT-II Events, Protection,
Data Load Management PRLM, CEC Signal, Diagnostics, NetObjectMgmt.

Length
This is the number of bytes in the message packet.

Transaction Time
This is the time stamp of the packet.
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IntelliTeam 1I/SG Communications Totals

TxFragCount
This is the number of packets transmitted. Each packet is a fragment.

RxFragCount
This is the number of packets received. Each packet is a fragment.

TxTotalCount
This is the total number of bytes transmitted.

RxTotalCount
This is the total number of bytes received.

SCADA Master Communications

The counters and statistics are associated with peer communications for each
SCADA master.

Port
The port connected to the control.

TX/RX
This indicates whether the packet was transmitted or received.

Scr/Dest

This is the destination address for a transmitted message and the source address for a
received message.

Application Control
This is part of the DNPV3 message header.

Function Control
This is part of the DNPV3 message header.

IIN 1
This is part of the DNPV3 message header.

IIN 2
This is part of the DNPV3 message header.

Length
This is the packet length in number of bytes.

Transaction Time
This is the time stamp of the packet.
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SCADA Master Communications Totals

TxFragCount
This is the number of packets transmitted. Each packet is a fragment.

RxFragCount
This is the number of packets received. Each packet is a fragment.

TxTotalCount
This is the total number of bytes transmitted.

RxTotalCount
This is the total number of bytes received.

Other DNP V3 Communications

This report notes the counters and statistics associated with peer communications for
DNP V3 Communications.

Port
This is the port connected to the control.

TX/RX
This report indicates whether the packet was transmitted or received.

Scr/Dest

This is the destination address for a transmitted message and the source address for a
received message.

Application Control
This is part of the DNPV3 message header.

Function Control
This is part of the DNPV3 message header.

IIN 1
This is part of the DNPV3 message header.

IIN 2
This is part of the DNPV3 message header.

Length
This is the packet length in number of bytes.

Transaction Time
This is the time stamp of the packet.
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Other DNP V3 Communications Totals

TxFragCount
The fragment is the packet. This is the number of packets transmitted.

RxFragCount
The fragment is the packet. This is the number of packets received.

TxTotalCount
This is the total number of bytes transmitted.

RxTotalCount
This is the total number of bytes received.

- - File Connection Data  Took  Help
Diagnostics (RON 8,8
5, IntelliRupter® iunwhdu. IR Location: Streat Address Setlings Applied Successiully
Eutwecionsr | [ =] Dingnostics>Ethemat

Operation Cmm|Mdm_lmimwmmim|mm|w.w|atm

IntelliTeam SG — Last Cloas Timo

z’;;':mg Clears both Ethermet Port statistics and DNP Link and Transport statistics. Link Status ks not cleared

Diagnaostics @ Ethemet Ports

fmmunmmn Tests P . - "
RX Recered o
RX Handled o
RX Multicast Dropped 0
RX Dvopped No Handler 0
RX Dropped No Buffer  NA
RX Ermors 0 s
RX Overnn o
TX Queued (1]
TX Allocated o
TX Transmittod 0
TX Unqueued Mo Butfer 0
TX Allocabon Errors o
Link Status. 00000000
RX Siza o
TX Size 1]

© Tceip
TCP Sockets Avadable o
TCP Sockets Avadable for DNP 0
@ ONP Link and Transport
[ swisic Vae|
RX Recaved o
RX Handled o
X Nenenod N Rutter 11
Eamc:u LEBRARYY 5-20 Sampile Files 6. 3Chosed_15-27kV.vm | Auta, at 1000ms. | 2:42:46 PM !—SIwiIW

Figure 19. The Diagnostics>Ethernet screen.

Clear Button

This button clears the DNP link and transport statistics. It also enters a time stamp in the
Last Clear Time field. See Figure 19. The following parameters are reported:

Last Clear Time

This time stamp registers the last Clear command. Recently cleared counters represent
present communications performance more accurately.
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Ethernet Ports
These counts show Native and Add-On Port link status.

For IntelliRupter fault interrupters, the catalog number SDA-4540R3 control module
has Ethernet 1 and Ethernet 2 ports. Ethernet 1 is the Native port and Ethernet 2 is the
Add-On port.

RX Received
This is the total number of received packets. The total is calculated with this equation:

RX_RECEIVED = RX_HANDLED + RX_MULTICAST + RX_FAULTS + RX_DROPPED

RX Handled
This is the total number of recognized and handled packets.

RX Multicast Dropped

This is the total number of multicast packets received. S&C controls do not support multi-
cast packets. Therefore, all received multicast packets are dropped.

RX Dropped No Handler
This is the total number of dropped packets with no handler.

RX Dropped No Buffer
This is the total number of dropped packets with no buffer.

RX Errors

This is the total number of erroneous packets: misaligned packed, broken CRC, or wrong
length. This statistic is only available for the add-on Ethernet port.

RX Overrun
This is the number of detected hardware (chip) errors.

TX Queued
This is the total number of packets queued for sending.

TX Allocated
This is the total number of allocation requests.

TX Transmitted
This is the total number of successfully transmitted packets.

TX Unqueued No Buffer
This is the total number of packets not queued because of a lack of buffer space.

TX Allocation Errors

This is the total number of allocation request failures. This statistic is only available for the
add-on Ethernet port.
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Link Status
This report shows the PHY Link Status Registers:

PHY registers 1, 18 of SMSC LAN91C111 chip for add-on Ethernet port.
PHY registers 1, 18 of AM79C874 or 1, 16 for DP83848 chip for native Ethernet port.

TCPI/IP

This report shows the following parameters:

TCP Sockets Available
This is the number of available TCP sockets.

TCP Sockets Available for DNP

This is the number of available TCP sockets for DNP3 traffic only. DNP-P2P does not use
the TCP/IP protocol.

DNP Link and Transport
This is the counters associated with DNP communications.

RX Received

This is the number of DNP packets recognized in the input stream. The total is calculated
with this equation:

RX_RECEIVED = RX_HANDLED + RX_FAILURES

RX Handled
This is the number of DNP packets routed and passed to the application layer.

RX Dropped No Buffer
This is the number of DNP/UDP frames dropped because of a lack of free packet buffers.

RX Overrun
This is the RX buffer of a given port was overrun and its contents were dropped.

RX Dispatch Self

This is the dispatcher recognized the RTU address equal to FFFC (65,532), the DNP Self
Address.

RX Dispatch Local

This is the dispatcher recognized the RTU address equal to one of the local addresses or
FFFC (65,5632), the DNP Self Address.

RX Dispatch Remote

This is the dispatcher recognized the RTU address equal to one of the remote addresses to
be routed.
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RX Dispatch Broadcast

This is the dispatcher recognized the RTU address equal to one of the broadcast addresses:
FFFD-FFFF; 65,633-65,535.

RX Dispatch Application
This is the packet is dispatched to the application layer.

RX Dispatch EOS
This is the packet is dispatched to the EOS simplified DNP sockets.

RX Out of Sockets

This is the packet that failed to be dispatched to the EOS-simplified DNP sockets because
of a lack of available sockets.

RX Bad Config

This is the packets violate routing tables, with wrong destination ports, etc.

TX Queued

This is the packets are queued for transmission to serial ports or are waiting for MAC
resolution via ARP.

TX Transmitted
This is the packets have been successfully sent.

TX Failures

These are the packets that failed to be sent because of a changed serial protocol or a UDP/
IP problem.

OOB Size
This is the out-of-bound data and skipped traffic.

RX Size
This is the received packet bytes.

TX Size
This is the transmitted packet bytes for all serial ports.
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Figure 20. The Diagnostics>Tests screen.

The screen in Figure 20 enables conducting Open, point-on-wave (POW) Close (this
function is labeled Close on the R2 control), Fast Close (R3 control only), Pulse Test,
PulseClosing® Technology, and Battery tests. The test results are shown on the Diagnos-
tics>Alarms, Diagnostics>Warnings, and Diagnostics>Errors screens.

Control Status

This field shows the same data displayed for the Control Status state on the Opera-
tion screen.

Request Open

The open test may be performed with the IntelliRupter fault interrupter in the Closed
position and in an Error state.

Point-On-Wave (POW) Close Test (labeled close on the “R2” control)

When this test is performed when selected, the IntelliRupter fault interrupter will execute
a point-on-wave closing where each pole is independently closed on a voltage peak.

PulseClosing Technology Test

When this test is performed when selected, the IntelliRupter fault interrupter will execute
a test using a pulse on each pole before closing it.

46 S&C Instruction Sheet 766-550



Diagnostics

Request Fast Close (“R3” control only)

When this test is performed when selected, the IntelliRupter fault interrupter will close all
three poles in < 2 milliseconds.

Pulse Test

This test performs a pulse and inverse pulse on the poles selected by the Single-Phase
Open/Close buttons. The IntelliRupter fault interrupter does not perform a Close opera-
tion at the end of the test, even when no fault is detected. When both the pulse and inverse
pulse detect a fault, a “PulseClosing detected a fault” message appears on the Operation
screen, and the corresponding DNP Status Points 55, 91, 92, and/or 93 will go active.

If the Single-Phase Tripping mode is enabled, any combination of poles can be
selected to run a test using a pulse. One or more poles can be selected on this screen with
the Pole Selection buttons, and the pulse-test execution will pulse and inverse-pulse test
the selected poles one pole at a time. The single-phase Pulse Test operations execute even
when one or two poles are presently in the Closed position.

If the Single-Phase Trip mode is disabled, the test is performed on all three poles.
All poles must be in the Open position or the Pulse Test command will be ignored. If any
pole detects a fault on both the pulse and inverse pulse, a “PulseClosing detected a fault”
message is displayed on the Operations screen, and the corresponding DNP Status Points
55, 91, 92, and 93 are set.

The Pulse Test command uses a select-before-operate command, so clicking on
the Pulse Test button opens a dialog box, where the user confirms execution of the
switch action.

Battery Test
This test displays one of these results:

Normal—Enough charge is present to operate the electronics.

Battery Low—The battery is in marginal condition.

Battery Bad—The battery charge is too low to operate the electronics.
Low Impedance—The calculated battery impedance is too low to be valid.
Disconnected—The battery is not connected.

Testing—The battery test has not completed.

Single-Phase Open/Close

These buttons select a single-phase test operation on the selected phase(s). The five-
minute Enable Operation Timer operation starts when one of the phases is selected.
When the timer is running, it restarts when a test is started. These buttons only function if
the Single-Phase Trip mode has been enabled in the profile and has not been blocked by
a user command. The state is changed by clicking on the button.

Pole Status
The present Open or Closed status is indicated for each pole.
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Alarms

Connectedto. IR Location: Streel Address
@ - =)
Counters | Control Power | Comm | Port Communications | Ethemet | Tests BAEIIEN Warnings | Errors.

Last Cloar Tme

Stalus Description Active Total Count
Application Board Calibration Data Invalid 0
CCP Board Calibration Data Invalid
CFM: Serious Disk Problem
CF Disk Tampered Indication
Last Settings Backup UnSuccess
Last Settings Reslore UnSuccess
BMM Mech. Data Read Problem
BMM Mech. Data Save Problem
BMM Calibr. Data Read Problem
Mechanism Alarm
Excessive Overiravel
Capacitor charge disabled alarm
Primary lemp sensor issue
ATXRun timeout
Control Calibration Data Issue
Phase Rotation Indeterminate Alam
Total Capacity is below 80 %
WAFi Intrusion Active
Log Flooding

[ Py IntelliRupter®
Iy Fault Interrupter

Diagnoshics>Alams

Operation

IntelliTeam SG

Setup

g_eferfﬂg Time Active Time Cleared |
£l

Communication Tests

Logs

~CooOocCcOoOoOOCcOCCOCOODOOOOO

111172016 10:45:44 838 11/11/2016 11:40:04.659

Burmese 7.1 Sample Files 7.1\Closed_38KkVovm | Auto, at 1000ms. | 12:25:19 PM [stop| | RAW

Figure 21. The Diagnostics>Alarms screen.

Clicking on the Clear Alarms button will reset any active alarms and update the Last
Clear Time and Time Cleared fields. Approximately one second after an alarm is cleared
it will reassert if the alarm check is a system check and the condition still exists. Issues
with capacitor charging, mechanism operations, and some other operational checks will
reassert the alarm on the next operation attempt if the condition still exists. See Figure 21

and Table 1.
Table 1. Alarms
Statustigzscrip- Active When Clear When Impact Recommended Action
Restarting the control may correct
Application Application board cali- this condition. If problem persists,

Board Calibra-
tion Data Invalid

bration data is invalid
at startup

Application board cali-
bration data is okay

Sensing accuracy may be compro-
mised when these alarms are active

save a memory snapshot (*.vm file)
and contact the S&C Global Support
and Monitoring Center (GSMC) for
further diagnosis

MCU processor did
not issue a command
issued by the ATX
automatic operations

Handshake completed,
ATXRun command

No protection and no automatic

Automatic function has been
suspended on startup. Try restarting
the control or reloading firmware. If

module

ATXRun Timeout logic in a timely received by DSP from functions problem persists, save a memory
fashion. Suspended MCU in the allotted time snapshot (*.vm file) and contact S&C
protection mode GSMC for further diagnosis
started

BMM Calibr. Not able to load cali- Calibration data was Restarting the control may correct

Data Read ’ bration data from the fsrlé(;ﬁ?ﬁ:fggééoaiﬁor i?:esénv%ha:: Ltjrr;?é r;g’;,gg g?(;napcrtci)\-/e this condition. If it does not, contact

Problem base memory module y S&C GSMC for further diagnosis
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Table 1. Alarms—Continued

Status Descrip-
tion

Active When

Clear When

Impact

Recommended Action

BMM Mech. Data
Read Problem

Mechanical operation
data was not success-
fully read from the
base memory module

Mechanical operation
data was successfully
read from the base
memory module

Sensing accuracy is compromised
when these alarms are active

Issue a Clear Alarms command

on the Diagnostics>Alarms>Clear
Alarms screen. If the Alarm does not
clear, restart the control using the
IntelliLink software menu: Tool>De-
vice Maintenance>Restart Control
option. If the alarm still does not
clear or it returns, then stop. Save

a memory snapshot and mech file.
Contact S&C GSMC for support

BMM Mech. Data
Save Problem

Mechanical operation
data could not be
saved to the base
memory module

Mechanical operation
data was successfully
saved to the base
memory module

None

Restarting the control may correct
this condition. If it does not, contact
S&C GSMC for further diagnosis

Capacitor charger

Capacitor voltage

May be an indication of aging capac-

Monitor. Typically corrects next
charge cycle. If the indication

Tampered Indi-
cation

directory contents
corruption was
detected on startup

contents corruption was
not detected on startup

8ﬁg?cgor is turned off due to falls to 400 V and the itors. May affect operation if alarm ?e\;?rl]s:ﬁé)sg\r/% ié?]f;?g&%%)sspﬂ%
Disagled Alarm excessive capacitor chargers are turned condition does not end before the fo'r further diaanosis. The capacitors
voltage back on capacitor charge drops below 200 V may need che?nging-or the ppower
supply may need service
Restarting the control may correct
CCP Board CCP board calibra- S . . this condition. If problem persists,
Calibration tion data is invalid at dceﬁs ig%akrg calibration ﬁw?snescljn\?/r?:r? L,:;Z?é 2@;52 g?énapégv e save a memory snapshot (*.vm file)
Data Invalid startup Y and contact S&C GSMC for further
diagnosis
Restarting the control may correct
CF Disk Compact flash Compact flash directory this condition. If problem persists,

Event data may be lost

save a memory snapshot (*.vm file)
and contact S&C GSMC for further
diagnosis

Restarting the control or applying

Calibration Data
Issue

board or CCP board
calibration data CRC
is bad

All control calibration
data CRCs are okay

CFM: Serious Problem with compact | No problem with settings may correct this condition. If
Disk Problem flash card compact flash card Data cannot be logged it does not, contact S&C GSMC for
further diagnosis
Issue a Clear Alarms command
on the Diagnostics>Alarms>Clear
f Alarms screen. If the alarm does not
gglrlngltérsrent When coil diver scdiig'as(jsf%?;girg?gn Re-occurrence can be an indicator clear, restart the control using the
Problem current measurements P Py IntelliLink software menu: Tool>De-
h where current measure- | of a mechanical issue or coil driver . :
are outside acceptable e ) vice Maintenance>Restart Control
(SDA-4540R3 ments are within board issues ) h
| parameters acceptable parameters option. If the alarm still does not
only) p p clear or it returns, stop and save a
snapshot and mech file. Contact S&C
GSMC for support
’ o Restarting the control may correct
Control Either the application this condition. If problem persists,

Sensing accuracy may be compro-
mised when these alarms are active

save a memory snapshot (*.vm file)
and contact S&C GSMC for further
diagnosis
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Table 1. Alarms—Continued

Status Descrip-

only)

and other devices on
the control board

tion Active When Clear When Impact Recommended Action
Issue a Clear Alarms command
on the Diagnostics>Alarms>Clear
. Alarms screen. If the alarm does not
CPLD Commu- X\Qi?)rr: Zgg?g:;'s clear, restart the control using the
nication Problem Communications are . . IntelliLink software menu: Tool>De-
(SDA-4540R3 between the GPLD normal Possible hardware issue vice Maintenance>Restart Control

option. If the alarm still does not
clear or it returns, stop and save a
snapshot and contact S&C GSMC
for support

Excessive Over-
travel

Mechanism travel
during operation is too
large

Mechanism travel
during operation is okay

None. May be an indication of wear

Monitor. Typically self-corrects after
an operation or two

IntelliLink Intru-
sion

IntelliLink software
access was attempted
by an unauthorized
user

Manually cleared

Security violation attempt

Review software access procedures

Last Settings
Backup UnSuc-
cess

An issue was
encountered storing
user settings to the
base memory module.
The settings were not
successfully stored

User configurable
settings successfully
stored to the base
memory module

Settings could be lost if the control is
restarted or changed

Applying settings may correct this
condition. If problem persists, save
a memory snapshot (*.vm file) and
contact S&C GSMC for further
diagnosis

Last Settings
Restore UnSuc-
cess

An issue was encoun-
tered restoring user
settings from the base
memory module. The
settings were not
restored

User configurable
settings successfully
restored from the base
memory module

Settings may not be up to date,
resulting in unexpected operation

Restarting the control may correct
this condition. If problem persists,
save a memory snapshot (*.vm file)
and contact S&C GSMC for further
diagnosis

Leakage Current

Vacuum interrupter
leakage current is

Leakage current is no

Problem with the vacuum interrupter

Contact S&C GSMC

active

active

Check Alarm detected longer detected may require maintenance
Download the logs and issue a Clear
Alarms command on the Diagnos-
tics>Alarms>Clear Alarms screen. If

) . . the alarm does not clear, restart the
I(_Sog ; fgf&r}?s aDr?m%)?;ei;/:c;;Whligqh Qgrirr:agéeg;(ﬂﬁg?:g Important information in the logs may | control using the IntelliLink software
; : be lost menu: Tool>Device Mainte-

only) number of log entries | entries have stopped nance>Restart Control option. If the
alarm still does not clear or it returns,
stop and contact S&C GSMC for
support

. Rollup point for any . None. This alarm is a rollup point for Gather information on the other
Xllzfrr:]anlsm mechanism alarm gl;iyeechanlsm alarm any mechanism-related alarm that is | alarm(s) that are active and follow

each troubleshooting procedure

Phase Rotation
Indeterminate
Alarm

Phase rotation cannot
be determined

Phase rotation can be
determined

Directionality not functional; three-
phase voltage elements, open source
element, and sectionalizer are
blocked

Wait 5 minutes for control to recalcu-
late or apply settings
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Table 1. Alarms—Continued

Status Descrip-
tion

Active When

Clear When

Impact

Recommended Action

POW Long Delay
(SDA-4540R3
only)

When time to
complete a Point on
Wave Close operation
exceeds expected
limits

Cleared on the next
successful Point on
Wave Close operation
has been completed

Re-occurrence can be an indicator of
a mechanical issue

Issue a Clear Alarms command

on the Diagnostics>Alarms>Clear
Alarms screen. If the alarm does not
clear, restart the control using the
IntelliLink software menu: Tool>De-
vice Maintenance>Restart Control
option. If the alarm still does not
clear or it returns, stop and save a
snapshot and mech file. Contact S&C
GSMC for support

Primary Temp
Sensor Issue

Temperature sensor
output is out of
expected range.
Readings are less
than -40°C (-40°F) or
greater than +85°C
(185°F)

Temperature sensor
output is within the
expected range

Capacitor-capacity calculation is
compromised and may result in a
capacity alarm

Issue a Clear Alarms command

on the Diagnostics>Alarms>Clear
Alarms screen. If the alarm does not
clear, restart the control using the
IntelliLink software menu: Tool>De-
vice Maintenance>Restart Control
option. If the alarm still does not
clear or it returns, then stop. Save

a memory snapshot and mech file.
Contact S&C GSMC for support

Total Capacity is
Below 80%

Energy storage
capacity has dropped
below 80% of its
nominal value

Energy storage capacity
is at least 80% of its
nominal value

None

Bypass the IntelliRupter fault
interrupter and manually operate the
IntelliRupter fault interrupter.

If the alarm does not clear, contact
S&C GSMC for support. If the alarm
does clear but then returns after the
next operation, contact S&C GSMC
for support. Do not swap control
modules in an attempt to trouble-
shoot

Wi-Fi Intrusion
Active

Wi-Fi intrusion acti-
vated by attempted
access by unautho-
rized user

Wi-Fi intrusion cleared

Possible Wi-Fi intrusion attempt

Implement your company’s security
policy for equipment intrusion
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Warnings R
File | Connection Data Tools Help
L2 S Validate Apply Reset

IntelliRupter® Connected to: IR Location:  Street Address Settings Applied Successfully
FaultInterupter || (] [ eonosteowemines ||

Operation | Counters | Gontrol Power | Comm | Port Communications | Ethemet | Tests | Alarms USRIl Errors |

IntelliTeam SG RSN Lest Clear Time  11/1672016 11:37:15.000

Setup = =

Metering | Status Description Active Total Count Time Active Time Cleared

Diagnostics Charger Overvollage

Communication Tests Baftery Low

Logs BMM Is Not Ready

Nonfunctional IPM

Battery Bad

‘Waming - Secondary Not Opening

No Encoder Reset

No Contact Touch

Puise Contact Touch Out of Range 3 times
Close Contact Touch Out of Range 3 times
Current Profile incormect

Remaining Comnact Wear Low

Bad Voliage Sensor

No Encoder Qutput

BMS Status

[ - - - - - - - - - - - - -

Figure 22. The Warning Diagnostics screen.

Clicking on the Clear Warnings button will reset any active warnings and update the
Last Clear Time and Time Cleared fields. Approximately one second after a warning

is cleared, it will reassert if the warning check is a system check and the condition still
exists. Issues with capacitor charging, mechanism operations, and some other operational
checks will reassert the warning on the next operation attempt if the condition still exists.

See Figure 22 and Table 2.
Table 2. Warnings
Statustigsscrlp- Active When Clear When Impact Recommended Action
The Bad Voltage
Sensor warning is
activated when any Issue the Clear Warnings command
of the six voltage on the Diagnostics> Warning>Clear
sensors is above ; ] Warnings screen. If the warning does
o h Warning will also place all Intel- :
systor phose-to- IMeam software-elted eams (f | [GliCink sofwar men: Toobbe.
samples. Also, a the rollup Warning: Mechanism restart, monitor for recurrence. If the
Bad Voltage Bad Voltage Sensor Bad Voltage Sensor Warning. When this warning is active, warninb comes back every two to
P : protective functions such as voltage :
Sensor warning is activated cleared three days, then stop. If the warning

when the difference
between the X and

Y side voltages of a
pole exceeds 12.5%
of system nominal
phase-to-ground
voltage for four
consecutive 1-second
samples while the
pole is closed

trip and automatic functions such as
sectionalizing may be compromised.
It is recommended these functions
be disabled until this condition is
resolved. Loop Restoration (if used)
will be “Not Ready”

still does not clear after the restart
or for firmware 6.1.x and higher if
voltages are in the red, then stop.
Save a memory snapshot and the
latest Compact Flash Wave Form
Capture (*.wfc). Then, contact S&C
GSMC for support. Do not swap
control modules to troubleshoot
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Table 2. Warnings—Continued

Status Descrip-

Low setpoint found on
the Diagnostics>Con-
trol Power screen

Voltage Low setpoint

tion Active When Clear When Impact Recommended Action
The battery voltage is
ltﬁzsstgftgfr\?gﬁgl t: The battery voltage is The IntelliRupter fault interrupter will
Battery Bad Bad setp o‘i,nt foun% on greater than the Battery | not operate if system power is lost Replace battery
the Diagnostics>Con- Voltage Bad setpoint when this condition exists
trol Power screen
This condition is normal after an
extended period of time without
system voltage, or right after a restart
from and extended outage that led to
. battery disconnect. If this condition
E;z ?ﬁ;‘ﬁx\gﬂbag?c;s ) occurs when there hasn’t been an
the Batter Vglta e The battery voltage is Batter_y is at the Battery Voltage Low | interruption of system power, it is an
Battery Low Y g greater than the Battery | setpoint shown on the indication there may be a problem

Diagnostic>Control Power screen

with the battery or battery charger.
Under these circumstances, replace
the battery. If the condition persists,
save a memory snapshot (*.vm file)
and contact the S&C Global Support
and Monitoring Center (GSMC) for
further diagnosis

BMS: Impedance
Status

Battery Impedance
Low

Battery Impedance
Normal

Battery impedance is an indica-
tion of battery health. If this error
is persistent, it is an indication the
battery performance will be limited
if the system is operating in a
Battery Backup mode

Issue a battery test. If the condition
does not clear, replace the battery
or the communication module with
one that has a known good battery.
If the condition does not clear, there
may be an issue with the battery
charger in the control module. Save
a memory snapshot (*.vm file) and
contact S&C GSMC for further
diagnosis

BMM: Is Not
Ready

A base memory
module, BMM, was
not detected on power
up, or did not respond
to a read or write
request

BMM is ready

Sensing accuracy may be compro-
mised when this warning is active.
Setting changes may be lost when
this warning is active. Manufacturing
data may be incorrect. Operation data
may be incorrect. Command status
may not be stored. Netlist copy in the
BMM may not be current

If the warning persists, save a
memory snapshot (*.vm file), and
contact S&C GSMC for further
diagnosis
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Table 2. Warnings—Continued

Status Descrip-

Overvoltage

voltage

Battery Charger Normal

may compromise operation of the
IntelliRupter fault interrupter when
system power is lost

tion Active When Clear When Impact Recommended Action
If the settings in the BMM are the
correct settings to be used for the
IntelliRupter fault interrupter, it
may be necessary to reconfigure
the control with a backup of the
original settings. If a backup does
not exist, downgrading the control to
User configurable the previous version in use should
settings in the base allow retrieval of the settings. Create
BMM: Setti memory modulg are User configurable . . a backup of the settings, upgrade
: Settings not of a compatible settings have been The settings in the BMM cannot be the control, and set the control to
Mismatch version with the a Iié]d used by the control overwrite the BMM on next power
firmware in the control, pp up. If the settings in the control are
so they cannot be appropriate for the IntelliRupter fault
restored interrupter, applying settings and
pressing the Clear Warnings button,
or restarting the control, may clear
the warning. If the warning persists,
save a memory snapshot (*.vm file),
save Event Logs from Compact
Flash, and contact S&C GSMC for
further diagnosis
Secondary capacitor It is recommended that the control
bank is charging module be replaced and sent to
before the main bank . . . S&C for further analysis. S&C Field
Cap Banks reaches 380 V. That Main and secondary Sj%?é?wghtrh?slgtgg&ﬁi?gger;:/ulfe?&ﬁp Service should be consulted before
oo™ | G socondary capac. | diodes are okay. - | In serious damage to the IneliRupter | EEEECR TS BECTN B Te
itor bank isolating fault interrupter Save a memory snapshot (*.vm file)
diodes are short-cir- and contact S&C GSMC for further
cuited diagnosis
L . Pressing the Clear Warnings button
4 . May affect operation if the warning )
Copactor | g, | condtondses notend betore e | & esiring he conto ey cler
Charge charger problem and Capacitor charging Is capacitor charge drops below 200 V. save a merﬁory snapshot (*.vm fi‘le)
Disabled has disabled capacitor okay gégevctipalmtolrl_%haqge f(:irC)I;t)_s l;)elowt save event logs from compéct fIash,‘
charging will not oe er;:tel upter fault INterrupter | ang contact S&C GSMC for further
P diagnosis
There may be an open thermistor
in the communication module or an
issue with the battery charger in the
control module. Swapping communi-
cation modules is the simplest way
to isolate the source of the issue.
The battery will be overcharged and Pressing the Clear Warnings button
Charger Battery Charger Over- possibly damaged. Battery damage may also correct this condition. If

problem persists and the user cannot
determine which module the problem
is in, save a memory snapshot (*.vm
file) and contact S&C GSMC for
further diagnosis. Otherwise, contact
S&C GSMC to make arrangements
for the return and repair of the
affected communication or control
module
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Table 2. Warnings—Continued

Status Descrip-
tion

Active When

Clear When

Impact

Recommended Action

Close Contact
Touch Out of
Range 3 Times

Contact touch during
three consecutive
Close operations out
of range

Contact touch during a
Close operation okay

Indicates a mechanism issue may be
developing. No impact on operation
until it develops into an error, which
will then block operation

This condition will self-correct after

a successful operation. Press the
Clear Warnings button to clear this
warning. If the warning persists after
several operations, save a memory
snapshot (*.vm file) and contact S&C
GSMC for further diagnosis

Current Exceeds
Max Interrupting
Current

Current exceeds the
Maximum Inter-
rupting Current
setting.

Current is below the
Maximum Interrupting
Current setting

Indicates the current is higher than
the Maximum Interrupting setting.
The IntelliRupter fault interrupter will
not trip open for this high current
value and will rely on the upstream
circuit breaker to clear the fault

The condition will self-correct after
the current falls below the Maximum
Interrupting Current setting

Current Profile
Incorrect

The coil driver Current
Profile contains points
that are out of range
for three consecutive
operations

Current Profile does not
contain points that are
out of range

This warning will be generated

when testing a control module with

a secondary injection test system
using a mechanical simulator. The
warning will automatically clear

after the control operates an actual
IntelliRupter fault interrupter. It may
also be cleared by pressing the Clear
Warnings button on the IntelliLink
Diagnostics screen. When the control
is installed in an IntelliRupter fault
interrupter, this warning indicates a
mechanism or control module issue
may be developing. No impact on
operation until it develops into an
error, which will then block operation

This condition will self-correct after

a successful operation. Press the
Clear Warnings button to clear this
warning. If the warning persists after
several operations, save a memory
snapshot (*.vm file) and contact S&C
GSMC for further diagnosis

DPR: Prot. Prcsr
No Response

The DSP processor is
not responding

The DSP processor is
responding

Protection may not be available

when this warning is active. Loop
Restoration (if used) will be in the Not
Ready state. The DSP also may not
respond to commands issued through
IntelliLink software or SCADA, or
originating in the MCU application

Pressing the Clear Warnings button,
or restarting the control may clear
the warning. If the warning persists,
save a memory snapshot (*.vm file),
save event logs from Compact Flash,
and contact S&C GSMC for further
diagnosis

Excessive
Bounce

Excessive contact
bounce during an
operation using Pulse-
Closing Technology

Contact bounce okay

Indicates a mechanism issue may be
developing. No impact on opera-

tion until it develops into an error,
which will then block the operation.
However, this issue may result in a
Close operation instead of an opera-
tion using PulseClosing Technology

This condition will self-correct after

a successful operation. Press the
Clear Warnings button to clear this
warning. If the warning persists after
several operations, save a memory
snapshot (*.vm file) and contact S&C
GSMC for further diagnosis

Leakage Current
Check Warning

Vacuum interrupter
leakage current is
detected

Vacuum interrupter
leakage current is no
longer detected

Problem with the vacuum interrupter
may require maintenance

Contact S&C GSMC
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Table 2. Warnings—Continued

Status Descrip-
tion

Active When

Clear When

Impact

Recommended Action

Main Cap Bank
Low

Main capacitor bank
voltage is below
380V 180 seconds
after startup

Main capacitor bank
voltage is > 380 V
180 seconds after a
restart

Operation is inhibited until capacitors
are charged to 400 V

System voltages below the IPM
rating or excessive loads in the
communication module can result
in this condition. Pressing the Clear
Warnings button may correct this
condition. If problem persists, save
a memory snapshot (*.vm file) and
contact S&C GSMC for further
diagnosis

Rollup point for any

not functioning

warning is active

\I)/IVechanlsm mechanism warning No mechanism warning See other Mechanism Warnings See other Mechanism Warnings
arning active active
This condition will self-correct after
No contact tOUCh. Adequate contact touch | Indicates a mechanism issue may be a successfull opsration. Prass the .
No Contact for two consecutive for operations using developing. No impact on operation Clear Warnings button to clear this
Touch operations using PulseClosing Tech- until it devélops into an error, which warning. If the warning persists after
PulseClosing Tech- nolo will then block operation ’ several operations, save a memory
nology 9y P snapshot (*.vm file) and contact S&C
GSMC for further diagnosis
This condition will self-correct after
Encoder output Indicates a mechanism issue may be eélsetgcve"sasrf#ilnopse [ﬂ{t%r:{ E)r?:;rhﬁﬂ s
No Encoder too low during an Encoder output oka developing. No impact on operation warnina. If thegwarnin ersists after
Output operation using Pulse- p Y until it develops into an error, which 9. . gp
Closing Technology will then block operation several operations, save a memory
snapshot (*.vm file) and contact S&C
GSMC for further diagnosis
Encoder does not Encoder does reset -Ia-k;ﬁ c%%gcilftllﬁr:)v‘glrl astﬁ)la-cg:;esc;t %f’leer
reset to 0 counts to 0 counts prior to an Indicates a mechanism issue may be Clear Warnin ps but‘lon' to clear this
No Encoder prior to an operation operation using Pulse- developing. No impact on operation warnina. If thegwarnin ersists after
Reset using PulseClosing Closing Technology until it develops into an error, which severalgb erations sa%/ga memor
Technology or before or before a Close will then block operation snapshotp(* vm fiIe’) and contact séc
a Close operation oparation GSMC for further diagnosis
System voltages below the IPM
rating or excessive loads in the
communication module can result
Nonfunctional One or both Integral The battery and capacitor banks may | in this_ condition. Pressing the CI_ear
IPM Power Modules are All IPMs are okay not be properly changing when this Warnings button may correct this

condition. If problem persists save
a memory snapshot (*.vm file) and
contact S&C GSMC for further
diagnosis

Pulse Contact
Touch Out of
Range 3 Times

Contact touch during
three consecutive
Pulse operations out
of range

Contact touch during
Pulse operation okay

Indicates a mechanism issue may be
developing. No impact on operation
until it develops into an error, which
will then block operation. However,
this issue may result in a Close oper-
ation instead of an operation using
PulseClosing Technology

This condition will self-correct after

a successful operation. Press the
Clear Warnings button to clear this
warning. If the warning persists after
several operations, save a memory
snapshot (*.vm file) and contact S&C
GSMC for further diagnosis

56

S&C Instruction Sheet 766-550

TABLE CONTINUED »




Diagnostics

Table 2. Warnings—Continued

Status Descrip-

Low

equal to 10%

new

tion Active When Clear When Impact Recommended Action
Press the Clear Warnings button
. - - The IntelliRupter fault interrupter is to clear this warning. If the warning
ggnmtglcqlc\?ear Eg;ﬁg‘slg%ﬁ:: t(;arc t Eegn::;?elr:?h%%ng%%}ov;?ar nearing end of life. No impact on persists after several operations,

operation until the contacts can no
longer perform to specification

save a memory snapshot (*.vm file)
and contact S&C GSMC for further
diagnosis

Secondary Not

Secondary plunger
does not open during
an operation using

Secondary plunger
does open during an

Indicates a mechanism issue may be
developing. No impact on operation
until it develops into an error, which
will then block operation. However,

This condition will self-correct after
a successful operation. Press the
Clear Warnings button to clear this
warning. If the warning persists after

Sensor Issue

are out of range.
Readings are less
than -40°C (-40°F) or
greater than +85°C
(185°F)

secondary temperature
sensor is within allow-
able range

Opening PulseClosing Tech- g;lagsr?r:lo_rlleishlgglgulse- this issue may result in a Close oper- | several operations, save a memory
nology 9 ay ation instead of an operation using snapshot (*.vm file) and contact S&C
PulseClosing Technology GSMC for further diagnosis
g#épsu; C(:)fntatgryprlmary Pressing the Clear Warnings button
: and restarting the control may clear
Secondary Temp | temperature sensors | Output of primary or Capacitor-capacity calculation is the warning. If the alarm persists,

compromised and may result in a
capacity alarm

save a memory snapshot (*.vm
file), save compact-flash event logs,
and contact S&C GSMC for further
diagnosis

SEEPROM Issue

Problems with serial
EEPROM operations

No more problems
with serial EEPROM
operations

Sensing accuracy may be compro-
mised when these alarms are active

Pressing the Clear Warnings button
may correct this condition. If problem
persists, save a memory snapshot
(*.vm file) and contact S&C GSMC
for further diagnosis

Sleep Time
Indeterminate

Control has tripped by
VSLCE element and
the duration of last
power outage could
not be determined

Control has tripped by
VSLCE and the duration
of last power outage is
determined

No automatic close-back is taken
after control power is restored

Pressing the Clear Warnings button
may correct this condition. If problem
persists, save a memory snapshot
(*.vm file) and contact S&C GSMC
for further diagnosis

Slow Capacitor
Charge

Capacitor charging
too slow under normal
operation

Capacitor charging at
normal rate

Slow charging could affect open
interval times in a test sequence
configured with the minimum delay
times between tests

System voltages below the IPM
rating or excessive loads in the
communication module can result
in this condition. Pressing the Clear
Warnings button may correct this
condition. If problem persists, save
a memory snapshot (*.vm file) and
contact S&C GSMC for further
diagnosis

Total Capacity Is
Below 50%

Energy storage
capacity has dropped
below 50% of its
nominal value

Energy storage capacity
is greater than 50% of
its nominal value

ATX Error state is entered. No

protection and no automatic functions.

This condition could be the result of a
temperature-sensor issue. Otherwise,
the operation may be affected while
the

conditions resulting in this warning
exist. Low capacity could affect open
interval times in a test sequence
configured with the minimum delay
times between tests

Save a memory shapshot and mech
file. Contact S&C GSMC for support.
Do not swap control modules in an
attempt to troubleshoot

TABLE CONTINUED »

S&C Instruction Sheet 766-550

57



Diagnostics

Table 2. Warnings—Continued

Status Descrip-
tion

Active When

Clear When

Impact

Recommended Action

Unequal Cap
Voltages

Main and secondary
capacitor bank
isolating diodes have
an open circuit

Main and secondary
capacitor bank isolating
diodes are okay

Operating the IntelliRupter fault inter-
rupter with this condition may result
in serious damage to the IntelliRupter
fault interrupter

It is recommended that the control
module be replaced and sent to
S&C for further analysis. S&C Field
Service should be consulted before
operating the IntelliRupter fault inter-
rupter with a replacement control.
Save a memory snapshot (*.vm file)
and contact S&C GSMC for further
diagnosis
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Errors
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Mechanism Ermor
Emor - Position Incomect
Error - Close Posiion Out of Range
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Figure 23. The Diagnostics>Errors screen.

Clicking on the Clear Errors button will reset any active errors and update the Last
Clear Time and Time Cleared fields. Approximately one second after an error is cleared
it will reassert if the error check is a system check and the condition still exists.

Issues with capacitor charging, mechanism operations, and some other opera-
tional checks will reassert the error on the next operation attempt if the condition still
exists. Close operations are blocked while in the Error state. See Figure 23 and Table 3
on page 60.

When an Error state is present, the IntelliRupter fault interrupter can accept an
Open command, but not a Close command, and the IntelliTeam® SG Automatic
Restoration System or the Loop Restoration mode will not go into the Ready state.

A Clear Errors command restarts the control.
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Table 3. Errors

Status Descrip-
tion

Active When

Clear When

Impact

Recommended Action

The following E

rrors are reported by both Control Modules SDA-4540R2 and S

DA-4540R3

ATX Error State

The automatic opera-
tions logic, ATX, is in
an Error state

ATX Error state off

The IntelliTeam system and protection

are shut down. Operation is blocked.
Protection and automatic opera-

tion may be compromised. Loop
restoration (if used) will be in the Not
Ready state

Restarting the control and pressing
the Clear Errors button may clear
this error. Replacing the control
module will return the IntelliRupter
fault interrupter to normal operating
conditions. If this condition persists,
save a memory snapshot (*.vm file),
replace the control module, and
contact the S&C Global Support and
Monitoring Center (GSMC) for further
diagnosis

Save a mech file in additional to

Position Out of
Range

close position
measured out of range

close position measured
in range

are shut down. Operation is blocked.
Mechanical operation may be
compromised

Cap Not One of the capacitor Capacitor bank charging | Operation is suspended after the the memory snapshot. Do not swap
Charging banks is not charging | is okay capacitor voltage drops below 200V | control modules in an attempt to
troubleshoot.
Restarting the control and pressing
the Clear Errors button may clear
The IntelliTeam system and protection | this error. Replacing the control
E;Ziﬁ:]cgﬁsgoﬁgor are shut down. Operation is blocked. module will return the IntelliRupter
DSP Error oint for varibus erFr)ors DSP processor Error Protection and automatic opera- fault interrupter to normal operating
Condition gnd warnings detected condition off tion may be compromised. Loop conditions. If this condition persists,
by DSP ro%essor restoration (if used) will be in the Not | save a memory snapshot (*.vm file),
Y P Ready state replace the control
module, and contact S&C GSMC for
further diagnosis
Error—Close Stable mechanism Stable mechanism The IntelliTeam system and protection | Save a mech file in additional to

the memory snapshot. Do not swap
control modules in an attempt to
troubleshoot.

Do not replace or separate the control module from the IntelliRupter fault interrupter with a Close Position
Out of Range error. This error cannot be cleared. Moving a control module with this error will disable the
IntelliRupter fault interrupter into which the control is installed.

Error—Main Coil
Current

Coil driver circuit
test has detected a
problem

Successful coil driver
circuit test

The IntelliTeam system and protection
are shut down. Operation is blocked.
Mechanical operation may be
compromised

Restart the control using the Intelli-
Link software menu: Tool> Device
Maintenance>Restart Control
option. If the error does not clear,
reinstall the existing firmware on the
module already installed in the Intel-
liRupter fault interrupter. If the error
does not clear, replace the control
module with a known good module
and clear errors. If an error returns
immediately or after the next oper-
ation, then stop. Save the memory
snapshot and mech file. Contact S&C
GSMC for support
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Table 3. Errors—Continued

Table 2.
Warnings— Active When Clear When Impact Recommended Action
Continued
If the error returns after the next
operation, restart the control using
the IntelliLink software menu:
Tool>Device Maintenance>Restart
.- Control option. If the error returns
iiotlﬁ edggrsr :éit;jlc?slistihon ) ] ag_ain after the'ne_xt operation,
Error— after operation (i.e Pole moves to the The IntelliTeam system and protection | reinstall the eX|st|ng_f|rmware_ on
Position If a Close comn{aﬁd ex " are shut down. Operation is blocked. | the module already installed in the
pected position when | ;e chanical operati b IntelliRupter fault interrupter. If th
Incorrect results in an open commanded echanical operation may be ntelliRupter fault interrupter. e
interrupter or vice compromised error returns again after the next
versa) operation, replace the control module
with a known good module and clear
errors. If an error returns immediately
or after next operation, then stop.
Save a memory shapshot and mech
file Contact S&C GSMC for support
Restarting the control and pressing
e Clear Errors buton o e
Insuffici less than calculated Energy availability The IntelliTeam system and protection - heplacing !
nsufficient d lted in calculation was are shut down. Operation is blocked module may return the IntelliRupter
Energy During and resu - ’ - P " | fault interrupter to normal operating
0 : insufficient energy to sufficient for the last Mechanical operation may be . ’ e )
peration complete an operation compromised conditions. If this condition persists,
operation save a memory snapshot (*.vm file)

and contact S&C GSMC for further
diagnosis

Leakage Current
Check Error

Vacuum interrupter
leakage current is
detected

Leakage current is no
longer detected

Problem with the vacuum interrupter
requires maintenance

Contact S&C GSMC

Main Power Bus
Low

Analog value Main
Power Bus Low

Analog value Main
Power Bus Normal

The IntelliTeam system and protection
are shut down. Operation is blocked.
Sensing accuracy may be compro-
mised. Loop restoration (if used) will
be in the Not Ready state

Pressing the Clear Errors button
may clear this error long enough

to allow an emergency operation.
Replacing the control module will
return the IntelliRupter fault inter-
rupter to normal operating conditions.
Save a memory snapshot (*.vm

file), replace the control module,

and contact S&C GSMC for further
diagnosis

Mechanism Error

Rollup point for any
mechanism error
active

No mechanism error
active

See above mechanism related errors

Save a mech file in additional to
the memory snapshot. Do not swap
control modules in an attempt to
troubleshoot.

P5 Out of Range

Analog value P5 out
of range

Analog value P5 in
range

The IntelliTeam system and protection
are shut down. Operation is blocked.
Sensing accuracy may be compro-
mised. Loop restoration (if used) will
be in the Not Ready state

Pressing the Clear Errors button
may clear this error long enough

to allow an emergency operation.
Replacing the control module will
return the IntelliRupter fault inter-
rupter to normal operating conditions.
Save a memory snapshot (*.vm

file), replace the control module,

and contact S&C GSMC for further
diagnosis

TABLE CONTINUED »
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Table 3. Errors—Continued

Table 2.
Warnings— Active When Clear When Impact Recommended Action
Continued
Pressing the Clear Errors button
may clear this error long enough
The IntelliTeam system and protection tF({)eTJIlggnaglyntﬁre:ncecr)?\?rrcl:l:%%%ﬂ?\?vﬂi
P15 Out of Analog value P15 out | Analog value P15 in g':nz?nm gngunrégngtlobneligxcﬁd- return the IntelliRupter fault inter-
Range of range range ; 9 y may bt pro- rupter to normal operating conditions.
mised. Loop restoration (if used) will .
be in the Not Ready state Save a memory snapshot (*.vm
file), replace the control module,
and contact S&C GSMC for further
diagnosis
Restarting the control and pressing
the Clear Errors button may clear
Error during power this error. Replacing the control
Power Down down sequencing. The IntelliTeam system and protection | module will return the IntelliRupter
s . Control is still oper- Normal power down are shut down. Operation is blocked. | fault interrupter to normal operating
Eequencmg ating 30 minutes after | sequencing Protection and automatic operation conditions. If this condition persists,
rror power down event has may be compromised save a memory snapshot (*.vm
been detected file), replace the control module,
and contact S&C GSMC for further
diagnosis
The IntelliTeam system and protection | Restarting the control or replacing
Sensor - - are shut down. Operation is blocked. | the control may correct this condition.
Calibration Data gaetgsg%cgli'g'sggn geRrg?é gigbratlon data Mechanical operation may be If problem persists, save a memory
Issue Y compromised. Sensing accuracy may | snapshot (*.vm file) and contact S&C

be compromised

GSMC for further diagnosis

The following Errors are only reported by Control Module SDA-4540R2

Analog value A5 out

A5 out of Range of range

Analog value A5 in
range

The IntelliTeam system and protection
are shut down. Operation is blocked.
Sensing accuracy may be compro-
mised. Loop restoration (if used) will
be in the Not Ready state

Pressing the Clear Errors button
may clear this error long enough

to allow an emergency operation.
Replacing the control module will
return the IntelliRupter fault inter-
rupter to normal operating conditions.
Save a memory snapshot (*.vm

file), replace the control module,

and contact S&C GSMC for further
diagnosis

A15 out of Analog value A15 out

Analog value A15 in

Range of range range See above See above
Pressing the Clear Errors button
may clear this error long enou.gh
The IntelliTeam system and protection o allow an emergency operation.
are shut down. Operation is blocked. Replacing the control module will
A15+ out of Analog value A15+ Analog value A15+ in Sensing accuracy may be compro- return the IntelliRupter fault inter-
Range out of range range mised. Loop restoration (if used) will rupter to normal operating conditions.
be in the Not Ready state Save a memory snapshot (*.vm
file), replace the control module,
and contact S&C GSMC for further
diagnosis
D3.3 out of Analog value D3.3 out | Analog value D3.3 in
Range of range range See above See above
TABLE CONTINUED »
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Table 3. Errors—Continued

Status Descrip-

tion Active When Clear When Impact Recommended Action
The following Errors are only reported by Control Module SDA-4540R3
Pressing the Clear Errors button
may clear this error long enough
The IntelliTeam system and protection g)e%lllgg n%ntﬁrengg%?rgcl%%%i@nmi
CCP_PWR out Main Power supply out | Main Power supply in gr:ni?nm gnglﬂégpﬁztlobne'zggcﬁd' return the IntelliRupter fault inter-
of Range of range range g y may p rupter to normal operating conditions.

mised. Loop restoration (if used) will
be in the Not Ready state

Save a memory snapshot (*.vm
file), replace the control module,
and contact S&C GSMC for further
diagnosis

DSP_3V3 out of

DSP 3.3 V supply out

DSP 3.3V supply in

of Range

range

Range of range range See above See above
DSP_2V5 out of | DSP 2.5V supply out | DSP 2.5V supply in
Range of range range See above See above
DSP_1V8 out of | DSP 1.8 V supply out DSP 1.8 V supply in
Range of range range See above See above
DSP_P15V out DSP +15V out of DSP +15V in range See above See above

DSP_M15V out
of Range

DSP -15V supply out
of range

DSP -15V supply in
range

The IntelliTeam system and protection
are shut down. Operation is blocked.
Sensing accuracy may be compro-
mised. Loop Restoration (if used) will
be in the Not Ready state

Pressing the Clear Errors button
may clear this error long enough

to allow an emergency operation.
Replacing the control module will
return the IntelliRupter fault inter-
rupter to normal operating conditions.
Save a memory snapshot (*.vm

file), replace the control module,

and contact S&C GSMC for further
diagnosis

DSP_1V2 out of

DSP 1.2V supply out

DSP 1.2V supply in

Range of range range See above See above
DSP_5V out of DSP +5V supply out [ DSP +5V supply in See above See above
Range of range range

PG_5V6 out of +5.6 V supply out of :

Range range +5.6 V supply in range | See above See above
PG_1V3 out of +1.3V ly out of ;

Range range Supply outo +1.3V supply in range | See above See above
PG_5V out of +5V supply out of )

Range range upply ou +5 V supply in range See above See above
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Communication Tests
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Figure 24. The Communication Tests>Communication Tests screen.

Diagnostic communication tests determine whether nodes are responding to commu-
nication and how quickly they respond. Periodically scheduled tests run for one hour
and record response time, failure, and retry statistics. Any network node can send tests
to other network nodes. Test messages (Connection IDs) do not contain real data, but
they can be configured to mimic a typical coach or runner message. See Figure 24. These
parameters are reported:

Settings

These settings are configured on the Setup>Communications>Communication Tests
screen and displayed here for convenience.

Active Test

For the test in progress it can display: “Idle” (no test running), “Quick Diagnostic”
(manually started Diagnostic Test), “Scheduled” (scheduled diagnostic test), “Quick Keep
Alive” (manually started Keep Alive), or “Keep Alive” (scheduled Keep Alive).

Note: This reports for any test running on either the Diagnostic Communication Tests
tab or the Link Keep Alive Tests tab.

Messages So Far
This is the total number of messages transmitted by the running test.
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Retries

This is the number of retry transmissions sent when a node did not respond to the message
transmission within the number of seconds specified by the Time Delay Between
Retries setting on the Setup>Communications>DNP screen.

Response Pending
This indicates the test has transmitted a message and is waiting for a node response.

Test Suspended

This indicates a higher priority communication system event, such as a circuit event or
an IntelliTeam system operation, preempted the test. The test resumes when that event is
complete.

Bad Health Alarm

This indicates when any Link Health indicator is red (bad health) and resets when all red
Link Health indicators are off.

Communications Test

This test reports statistics for each message type sent to each node. The report sequence
follows this example if there are 2 nodes and 3 message types:

Node 1, Message Type 0
Node 1, Message Type 1
Node 1, Message Type 2
Node 2, Message Type 0
Node 2, Message Type 1
Node 2, Message Type 2

These parameters are reported:

DNP Address
This is the node address of the message.

Data Type ID
This is the message type, such as coach or runner.

Bytes Sent
This is the number of bytes sent in the message.

Bytes Received
This is the number of bytes received for the message.

Total Messages Sent
This is the number of transmissions for the message type.
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Total Messages Received
This is the number of responses for the message type.

Retry Count

This is the number of times a response was not received for this message type and the
message was retransmitted. The Number of Retries for Confirm setting is on the
Setup>Communications>DNP screen.

Fail Count

This is the number of times the message type was sent and no response was received, even
after the allotted number of retries.

Last 2way

This is the response time in milliseconds for the last two-way message-type response. This
is the interval from the start of transmission to receipt of the response. If a messages fails,
there is no two-way transmission report data. A completed retry counts as a two-way trans-
mission, and the timeout delay will be included in all two-way statistics.

Min 2way

This is the shortest response time in milliseconds for all two-way responses for this
message type.

Max 2way

This is the longest response time in milliseconds for all two-way responses for this
message type.

Avg 2way

This is the average response time in milliseconds for all two-way responses for this
message type.

Link Health Metric

This is the percentage of tests for this message type that had a response even if a retry
was required. This is the Total Messages Received count divided by the Total Messages
Sent count.

Link Health
This shows a color indication of the link health metric for this message type:

Gray-Less than 100 transmissions have been sent.

Red-Bad; link health metric is less than 25%.

Yellow-Marginal; link health metric is 25% or greater and less than 95%.
Green-Good; link health metric is 95% or greater.

These threshold settings can be adjusted in the “Peer Communications Statistics
Configuration” section of the Setup>Communications>DNP Diagnostics screen.
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Last Test

This is the time stamp of the last test statistics displayed. The test type can be reported as:
“Quick Diagnostic,” “Schedule,” or “Idle” (no test was run).

Clock
This is the present date and time.

Run Quick Test Button

This starts a quick test. The indicator shows the quick test status: Running, Stopped, or
Suspended. A quick test sends only one message (the first message type configured) to
each node and stops.

Scheduled Test

This enables or disables running the scheduled test. The indicator shows the scheduled
test status: Running, Stopped, or Suspended.

Last Start Time
This is the time stamp of the start of the last scheduled test.

Last Stop Time
This is the time stamp of the end of the last scheduled test.

Next Test
This is the scheduled time of the next test.

Daily Worst Performing Link History

This report shows the worst link performance for the last 10 scheduled tests. It aggregates
all message types sent to each node and reports statistics for the node with the worst link
health. These parameters are reported:

Time stamp
This is the time of the scheduled test.

DNP Address
This is the RTU address of the node.

Total Messages Sent
This is the number of transmissions for this message type to this node.

Total Messages Received
This is the number of responses for this message type received from this node.

Retry Count

This is the number of times a response was not received for this message type from this
node and the message was retransmitted. The number of retries is configured in the
Number of Retries for Confirm setting on the Setup>Communications>DNP screen.
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Fail Count

This is the number of times a message for this message type to this node was sent and no
response was received, even after the allotted number of retries.

Last 2way

This is the response time in milliseconds for the last two-way message response, this is the
interval from when a message was sent to when the response was received. If a message
fails, there will be no two-way transmission report data. A completed retry counts as a
two-way transmission, and the timeout delay will be included in all two-way statistics.

Min 2way
This is the shortest response time in milliseconds for all two-way message responses.

Max 2way
This is the longest response time in milliseconds for all two-way message responses.

Avg 2way
This is the average response time in milliseconds for all two-way message responses.

Link Health Metric

This is the percentage of tests that had a response even if a retry was required. This is the
Total Messages Received count divided by the Total Messages Sent count.

Link Health

This shows a color indication for link health metric:

Gray-Less than 100 transmissions have been sent.

Red-Bad; link health metric is less than 25%.

Yellow-Marginal; link health metric is 25% or greater and less than 95%.
Green-Good; link health metric is 95% or greater.

The threshold settings can be adjusted in the “Peer Communications Statistics
Configuration” section of the Setup>Communications>DNP Diagnostics screen.

68

S&C Instruction Sheet 766-550



Communication Diagnostics

Link Keep
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Figure 25. The Communication Tests>Link Keep Alive Tests screen.

The Link Keep Alive process periodically sends a single message to every node to keep
all links active because an idle TCP connection may be shut down. When more than one
message is configure d for a scheduled test, the Link Keep Alive process only sends
the first configured message and records statistics for the message transmissions. See
Figure 25. These parameters are reported:

Settings

These settings are configured on the Setup>Communications>Communication Tests
screen and displayed here for convenience.

Active Test

For the test in progress, the screen can display: “Idle” (no test running), “Quick Diag-
nostic” (manually started diagnostic test), “Scheduled” (scheduled diagnostic test), “Quick
Keep Alive” (manually started Keep Alive process), or “Keep Alive” (scheduled Keep Alive
process).

Messages So Far
This is the total number of messages transmitted by the running test.

Retries

This is the number of retry transmissions sent when a node did not respond to the message
transmission within the number of seconds specified by the Time Delay Between
Retries setting on the Setup>Communications>DNP screen.
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Response Pending
This indicates the test has transmitted a message and is waiting for a node response.

Test Suspended

This indicates a higher priority communication system event, such as a circuit event or
an IntelliTeam system operation, preempted the test. The test resumes when that event is
complete.

Bad Health Alarm

This indicates when any Link Health indicator is red (bad health) and resets when all
Link Health indicators are off.

Link Keep Alive Test

Only the first message type (Data Type ID) is sent to each node. This report shows
statistics for each node that aggregates until the statistics are cleared manually or clear
automatically at midnight. These parameters are reported:

DNP Address
This is the node address for the message.

Total Messages Sent
This is the number of transmissions for this node.

Total Messages Received
This is the number of responses received for this node.

Retry Count

This is the number of times a response was not received from this node and the message
was retransmitted. The number of retries is configured in the Number of Retries for
Confirm field on the Setup>Communications>DNP screen.

Fail Count

This is the number of times the message was sent and no response was received, even after
the allotted number of retries.

Last 2way

This is the response time in milliseconds for the last two-way message response, this is
the interval from the start of the transmission to receipt of the response. If a messages
fails, there is no two-way transmission report data. A completed retry counts as a two-way
transmission, and the timeout delay will be included in all two-way statistics.

Min 2way
This is the shortest response time in milliseconds for all two-way message responses.

Max 2way
This is the longest response time in milliseconds for all two-way message responses.
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Avg 2way
This is the average response time in milliseconds for all two-way message responses.

Link Health Metric

This is the percentage of tests that had a response even if a retry was required. This is the
total messages received divided by the total messages sent.

Link Health

This shows a color indication for the link health metric for this message:
Green—The last Keep Alive message was received successfully without any retries.
Yellow—The last Keep Alive message was received successfully with retries.
Red—The last Keep Alive message was not received successfully.

Note: For Keep Alive tests, the link-health calculations are based on the last message, but
for the Diagnostic Tests and Worst Performing Link History, the calculations are based on
averages.

Clear Button
This clears link keep alive test data.

Last Time Cleared

This is the time stamp of the last time statistics were cleared, either manually or automati-
cally, at midnight.

Last Message Sent
This is the time stamp of the last message transmission.

Clock
This notes the present date and time.

Run Quick Keep Alive Button

This button starts a quick keep alive test. The indicator shows the quick keep alive test
status: Running, Stopped, or Suspended. The quick keep alive test sends only one
message—the first message type configured—to each node and stops.

Recurrent Keep Alive Button

This button enables or disables running a recurrent keep alive test. The indicator shows
the recurrent keep alive test status: Running, Stopped, or Suspended.

Last Start Time
This is the time stamp of the last test start time.

Last Stop Time
This is the time stamp of the last test stop time.
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Next Test
This is the start time of the next recurrent keep alive test.

Daily Worst Performing Link History

This report shows performance of the worst link for the past 24 hours. At midnight, the
report aggregates all message types sent to each node and reports performance of the node
with the worst link health. It also clears the link keep alive table. These parameters are
reported:

Time stamp
This is the time of the node transmission.

DNP Address
This is the DNP address of the node.

Total Messages Sent
This is the number of messages sent to this node.

Total Messages Received
This is the number of messages received by this node.

Retry Count

This is the number of times a response was not received from this node and the message
was retransmitted. The number of retries is configured in the Number of Retries for
Confirm setting on the Setup>Communications>DNP screen.

Fail Count

This is the number of times a message for this node was sent and no response was
received, even after the allotted number of retries.

Last 2way (msec)

This is the response time, in milliseconds, for the last two-way message response, this
is the interval from when a message was sent to when the response was received. If a
message fails, there will be no two-way transmission report data. A completed retry counts
as a two-way transmission, and the timeout delay will be included in all two-way statistics.

Min 2way (msec)
This is the shortest response time, in milliseconds, for all two-way message responses.

Max 2way (msec)
This is the longest response time, in milliseconds, for all two-way message responses.

Avg 2way (msec)
This is the average response time, in milliseconds, for all two-way message responses.
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Link Health Metric

This is the percentage of tests that had a response even if a retry was required. This is the
total messages received divided by the total messages sent.

Link Health
This shows a color indication for the link health metric:

Gray-Less than 100 transmissions have been sent.

Red-Bad; link health metric is less than 25%.

Yellow-Marginal; link health metric is 25% or greater and less than 95%.
Green-Good; link health metric is 95% or greater.

Note: Link health in this table indicates the average of all messages, but Link Health in the
link keep alive table indicates the health for the last message sent.

These threshold settings can be adjusted in the “Peer Communications Statistics
Configuration” section of the Setup>Communications>DNP Diagnostics screen.
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Ping and
Serial Tests
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Figure 26. The Communication Tests>Ping and Serial Tests screen.

User-Initiated Ethernet Ping or Serial Link Status Request

The user can manually ping a node at the network level to test response time. This is useful
when statistics indicate a node is not responding at the messaging level and the user must
check that the node is responding at the network level. See Figure 26. These parameters
are reported:

Settings

These settings are configured on the Setup>Communications>Communication Tests
screen and are displayed here for convenience.

Run Ping Test Button
This button starts a ping test to the specified IP address.

IP Address
This is the IP address of the tested node.

Result

This is the Ping Test status reported as: “Pending” (waiting for a response), “Success,”
“Timeout,” “Bad Address or No Route,” “Interface Down,” “Unknown,” or “None” (no test
done yet).

2-Way Transit Time
This is the response time, in milliseconds, for the two-way message response.

Time stamp
This is the time stamp of the last ping sent or the response received.

Run Serial Link Test Button
This button starts a serial link test to the specified DNP address.
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DNP Address
This is the address of the tested node.

Port
This is the serial port used for transmission.

Result

This is the Serial Link Test status reported as: “Pending” (waiting for a response),
“Success,” “Timeout,” “Bad Address or No Route,” “Interface Down,” “Unknown,” or
“None” (no test done yet).

2-Way Transit Time
This is the response time, in milliseconds, for the two-way message response.

Time stamp
This is the time stamp of the last serial link test or the response received.
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File Connection Data Tooks Help

LT - J Validate &7 Apply Reset
IntelliRuptar® Connecledto: IR Location: Street Address Seltings Applied Successfully
PulseCloser = - =] IntelliTeam SG>Team Summary

Operation MEUETUTETY Team 1 | Team 2 | Team 3 | Team 4 | Team 5 | Team 6 | Team 7 | Team 8 | Activity Monitoring |
IntelliTeam SG DNP Addresses and Team Status
mrefing Team Member 1/ Member 2 Member 3 Member 4 Member 5 Member 6 Member 7 Member 8 Ready Status,
Diogrstes S — —————
Eg;mumcanon Tests st o 0 o o 0 o o o

Team 4 (i} o 0 (i} ] 0 o 0

Team 5 1] o 0 o o a 1] o

Team & (1] o 0 1] o 0 a o

Team 7 0 ] 1] 0 o 1] 0 [

Team & (1] o (1] 0 0 0 0 0

InteliTeam SG Restoration
Site Acceptance Test .

SAT Status: Inactive

SAT Version: No Script Loaded

Figure 27. The IntelliTeam SG>Team Summary screen.

The Ready status is indicated for each team. If a manual operation is issued, the team(s)
will go out of the Ready state. The manual operation can be cleared by clicking on the
Clear Manual Operation button at the bottom of the screen. See Figure 27.

All teams must be in the Ready state and the IntelliTeam SG Restoration mode
must be enabled for the IntelliTeam SG system to operate. To view individual team infor-
mation, click on the Team 1 through Team 8 tabs. The following parameters are reported:

Team
This is the team number for the listed data.

Member 1 through Member 8
This is the DNP address of the team member.

Ready Status
This is the Ready state of the team.

IntelliTeam SG Restoration

This slide control is used to enable or disable the IntelliTeam SG Restoration System from
this screen.

Site Acceptance Test

This slide control is used to enable or disable a Site Acceptance Test (SAT) script. Leave
this set to the Disabled state for normal operation.

SAT Status

This indicates status information for a Site Acceptance Test. During normal operation, this
indicator displays “Inactive.”
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Team Information

SAT Version:

This indicator shows version identification for the Site Acceptance Test script. If a SAT
script is not present in the control, this displays “No Script Loaded.”

Clear Manual Operation

Click on this button to clear a manual operation command issued from the local user inter-
face or by a SCADA command.
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Figure 28. The IntelliTeam SG>Team 1 screen.

The IntelliTeam SG> Team 1 screen displays team-related parameters and information
about each team member. See Figure 28. The following parameters are reported:

Team ID

This is the name entered in the Team ID field on the Setup>Restoration>IntelliTeam
SG>Team x screen.

Local Real-Time Load

This is the two-minute average three-phase load (in amperes) measured on the line
segment protected by this team. It does not include load outside the local line segment.

Real Capacity

This is the load capacity available on the line segment protected by this team. It takes
into account the real capacity of source-side teams, the maximum capacity of the team’s
present source device, and any load already transferred during circuit reconfiguration.
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Transfer State
This is the present state of any transfer operation. Possible values displayed:

Idle—Team configuration is normal. No Transfer or Return-to-Normal operations are
taking place.

Init—Data are being collected from team members in preparation for a Transfer event.
Rgst—The line segment is requesting service restoration from an adjacent line segment.

Grant—The line segment is being asked to grant service restoration to an adjacent line
segment.

Wait—The team configuration is not normal. The team is waiting for an additional circuit
reconfiguration or Return-to-Normal operation.

RTN—The team is returning to normal configuration.

Stop—An error has occurred, stopping a Transfer operation.

Fault—The team is presently isolating a fault.

Hold—The team has begun a Transfer event but the line segment is not yet fully

de-energized.

Ready Status
This is the present Ready state. Possible values displayed:

Ready—When Operation status, Configuration status, and Line Segment status all
indicate no errors are present.

Alarm—When errors are present.
Fault—The team is isolating a faulted line segment.
PLI—The team is isolating a Phase Loss event.

OverCurrent—The team is isolating an Overcurrent event.

Operation Status
This is the system operation status. Possible values displayed:

None—No Error conditions exist and team members can perform team operations.

Coordination—The team coach is not passing through the team, causing a lack of team
coordination.

Config Mismatch—The configuration of a team member is not consistent with the config-
uration of this IntelliTeam system device.

Remote Problem—At least one active team member contains Error conditions or the
team logic has been disabled.

Local Problem—The local team member contains Error conditions.

Logic Disabled—Team logic has been disabled on the Setup>Restoration>IntelliTeam
SG>Team x screen.

Not In Use—This team is not in use.

No 2nd Contin.—The team is in a transferred state and no further restoration activity is
allowed.
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Configuration Status

This is the status of user-configured parameters essential for team operation. Possible
values displayed:

None—No Error conditions exist in team configuration.
NoRTU Addr— No RTU address is specified on the Setup>Communications screen.

Stopped—The Set Team mode is in the Stopped state on the Setup> Restoration>
IntelliTeam SG>Team x screen.

Data Change—The team’s setup data have a CRC error.

Stop + Change—The Set Team status is in the Stopped state and the team’s setup data
have a CRC error.

Record Count—The count of team member records on the Setup> Restoration>
IntelliTeam SG>Team x screen is incorrect. The team database requires at least one
record to be valid.

Not 1 Source—An incorrect number of source devices was configured on the Setup>
Restoration>IntelliTeam SG>Team x screen. A team may have only one source switch.

No Local Rec—No local record was found in the team database. One of the team records
must contain a DNP Address configuration that matches the DNP Address setting entered
on the Setup>Communications>DNP screen.

Line Segment Status

This displays the status of the line segment protected by this team of IntelliTeam system
devices. Possible values displayed:

Good—No faults or voltage loss is detected on the line segment.
Segment Dead (Dd)—The line segment is de-energized.

Segment Open (Op)—All team members are in the Open position in preparation for a
circuit reconfiguration.

Overcurrent (OC)—An overcurrent is detected on this line segment.

Voltage Loss (VL)—A voltage loss is detected on this line segment.

Team Error (Er)—An error is detected.

Alt Source (AS)—The line segment is being fed by an alternate source, either directly

from an adjacent line segment or indirectly from another location.

Individual Team Member Status

DNP/RTU Adr

This is the DNP/RTU address of each team member, as entered on the Setup>Resto-
ration>IntelliTeam SG>Team x screen.

Sw/Pos Num

This is the position number associated with the team member, for example “Sw1” for
a single overhead switch, as entered on the Setup>Restoration>IntelliTeam SG>Team
& screen.
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Normal State

This is the state of each team member when the circuit is configured normally, as entered
on the Setup>Restoration>IntelliTeam SG>Team x screen.

Present State
This is the present position of each team member displayed as:

Open—Team member is open.
Closed—Team member is closed.

---- —The position of the team member switch is unknown or the record is not in use. This
is considered an Error condition during normal operation.

Auto Mode

This report notes the automatic features enabled for each team member, as entered on the
Setup>Restoration>IntelliTeam SG>Team x screen. This also indicates when the team
member has been temporarily placed in manual operation mode. A combination of values
can be displayed:

B—This switch is temporarily blocked from use as a valid source for the team during
the Reconfiguration event. This may be because of a loss of voltage at this switch, or this
switch is used to shed load following a reconfiguration.

M—The team member is temporarily placed in manual.

A—Automatic Sectionalizing logic is enabled.

V—Sectionalizing on Loss-of-Voltage logic only is enabled.
T—Automatic Transfer logic is enabled.

P—Sectionalizing on Phase Loss logic is enabled.
Ro—Return-to-Normal logic using Open Transition mode is enabled.

Rc—Return-to-Normal logic using Closed Transition mode has been enabled.

Internal Error
Possible values displayed:

None—No internal errors are present in a team member.

Trouble—A team member is disabled because of a bad battery or other condition.
NotAuto—A team member is in a non-automatic condition.

ManOR—The Open/Close state of a team member is manually overridden.

No Op—A Close or Open operation was requested but the team member is unable to
perform the operation.

Note: For all IntelliTeam SG devices, ManOR and No Op status can be cleared on the
IntelliTeam SG>Team Summary screen by clicking the Clear Manual Operation button
or with a SCADA command.

ProRes—The team member has been sent a Prohibit Restoration command.
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Event Status

This report notes the present status of events related to this team member.
A combination of values can be displayed:

O—Latched On for an Overcurrent event

V—Latched On for a voltage loss on any or all phases
P—Latched On for a phase loss during a Sectionalizing event
Vr—Real-time voltage loss on any phase

3Vr—Three-phase real-time voltage loss

C—A team member is in the Cycling state

Average Load

This is the two-minute average three-phase load reported by each team member. It is used
to determine the Local Real-Time Load value. To ensure the team uses pre-event values
during a transfer, it is frozen after the event at the last value reported before the event
began. The value is not updated until the transfer is complete.

Load Current Direction
This is the direction of load current. Possible values displayed:

N/A—There is presently no current flowing in the team.
No Dir—Load current direction is presently unavailable.

Out of Team—ILoad current is flowing out of the team. The switch is the load/tie point of
the team.

Into Team—ILoad current is flowing into the team. The switch is the present source of
the team.

Fault Current Direction
This is the direction of fault current. Possible values displayed:

N/A—There is presently no fault in the team.
No Dir—Fault current direction is presently unavailable.

Out of Team—Fault current is flowing out of the team. The switch is the load/tie point of
the team.

Into Team—Fault current is flowing into the team. The switch is the present source of
the team.
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Figure 29. The IntelliTeam SG>Team 1>Task and Coach Analysis screen.

Task and Coach Analysis

This screen displays team-related parameters and information about each team member.
See Figure 29. The following parameters are reported:

Coach ID

This is the identification number of the present team coach. When the coach is lost, the
next coach generated will have a higher ID number.

Coach Present
This indicates the team coach is present at this team member and shows the coach status.

Coach Counter

This is the number of times the present coach has arrived at team members. This is used
with the Coach ID to validate the coach when it arrives.

Coach Flags

This indicates the coach has arrived and left this team member. It shows that team data has
been refreshed.
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Coach Sw Rec
This indicates the coach is present at this team, it indicates where the coach is executing.

Team Visit Time

This indicates the remaining time in seconds before a new coach is generated. This timer
is refreshed while the coach is present. This team member will generate a new coach if the
coach does not return and the timer expires.

Crumb Trail

This is a database record allowing team functions to span multiple teams. Provides a path
back to the originating team.

RTN Activity
This is a database record indicating where the Return to Normal process originated.

Present Source

This is a database record showing the team member through which the line segment is
presently receiving power.

Segment Limit

This is the number of line segments allowed to be restored on this circuit. It is the lesser of
the limit configured by the Line Segment Limit setpoint on the Setup>Restoration>Intel-
liTeam SG>Team x screen and the limits set in the adjacent source-side teams.

Extended Load

This report notes extended team loading, which includes the line-segment loading and all
downstream load.

Local RT Load
This is the local real-time load on the line segment protected by this team.

Local Capacity

This is the loading capacity of the local team. This value is compared with the remote
capacity of the adjacent source-side team to determine the real capacity of the team.

Real Capacity
This is the loading capacity available on the line segment protected by this team.

Segments Added

This is the number of segments presently added. The team compares this value to the Line
Segment Limit setting on the Setup>Restoration>IntelliTeam SG>Team x screen when a
Transfer event occurs

The table in the center of the Task and Coach Analysis screen shows tasks presently
being executed. S&C Electric Company uses this information for diagnostic purposes.
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TaskiD
This identifies the task being executed.

TaskOwn

This indicates the team in which the task is being executed. A task may require global
execution at all team members.

TaskSeq
This is the sequence number of the task being executed.

TaskTTR
This is the time-to-run for the task being executed.

Visit Timer

This indicates the remaining time in seconds before the coach should visit a specific team
member. The coach carries the timer, which will only update while the coach is at the
team member.

Event Sequence
This is the sequence number of the last event received from this team member.
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Figure 30. The IntelliTeam SG>Activity Monitoring>Task Operation screen.

Figure 30 shows tasks presently being executed by the team member. S&C Electric
Company uses this information for diagnostic purposes. The following parameters are
reported:

ID
This identifies the task being executed.

Own
This is the team database record associated with the execution of this task.

Seq

This is the sequence number of the task being executed.

TTR
This is the time to run for the task being executed.

Attrib
This is the lock and execute attributes associated with the task being executed.

Team
This is the team number associated with execution of this task.
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Figure 31. The IntelliTeam SG>Activity Monitoring>Contract Status screen.

Figure 31 shows information about contracts associated with this team member. S&C
Electric Company uses this information for diagnostic purposes.

When a contract is required for a particular line segment, the contract agent is used
to track and secure the contract. Every contract request is uniquely identified by the
requesting agent and the originating segment, and it is time stamped when the request
is made.

Contract State
This field shows the present state of the contract. Possible values are:

Active—The contract has been granted and is presently active.

Rgst unsent—The contract agent received a contract request from the team member, but
has not yet sent the request to the next contract agent.

Rqst pending—The contract request is pending.

Rqst travel—The contract agent is forwarding the contract because the decision to grant
the contract cannot be made at this location.

Rqgst accept—The contract request was accepted by this agent and contract approval is
traveling to the originating agent. The contract is approved when contract approval arrives
at the originating agent.

Rqst decline—The contract request was declined by this agent. The request is returned to
the originating agent.
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Decline cont.—A declined message is being transmitted to the requesting agent.
Dissolve start—An agent (usually the requesting agent) is dissolving the contract.
Dissolve cont.—A dissolve message is being transmitted.

Maint start—The maintenance timer on an active contract has expired, causing the main-
tenance action to occur.

Maint tickle—The contract agent has not recently received a maintenance message
for the contract and sends a reminder to the requesting agent to determine whether the
contract is still required.

Maint travel—A maintenance message is being transmitted from the requesting agent to
other agents along the contract route.

Maint tra NF—The contract agent received a maintenance message for a contract that is
not found in its list.

Maint tra NF rt—A Maint tra NF message is being returned to the requesting agent.
This message can also appear at other agents along the contract route.

Maint tic NF—The contract agent received a tickle message for a contract that is not
found in its list.

Maint tic NF rt—A Maint tic NF message is being returned to the agent that initiated the
tickle. This message can also appear at other agents along the contract route.

Maint restart—The requesting agent confirmed that it still needs the contract, and the
maintenance timer is restarted.

Maint res cont.—A Restart message is being passed to other agents along the
contract route.

Rgst Agent
This is the agent that requested the contract.

Grant Agent
This is the agent that approved the contract.

Orig Segment
This is the database record number for the segment where the contract request originated.

Temp Segment
This is the database record number for the present location of the contract request.

Line Count

This is the number of line segments that will be picked up if the contract request is
granted. This value is usually 1.

Load Rqgst
This is the amount of load that will be picked up if the contract request is granted.
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Maint Timer

After a contract request is granted, this is the time remaining before contract maintenance
should be performed. When a contract is no longer needed, the requesting agent sends a
message to dissolve the contract. If the local contract agent does not receive a response
within the timer setting, it checks with the requesting agent. The requesting agent can
extend the contract if it is still needed or dissolve the contract if it is no longer required.

Rqst Time
This is the date and time when the contract was requested.
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Action Path

The IntelliTeam SG>Activity Monitoring>Action Path screen shows a table of the actions
taken during the execution of a switch operation. This information is used for diagnostic
purposes when working with S&C support engineers. See Figure 32.

Some switchgear requires different steps to be taken during the operation of the
switch than other gear. These steps are often further changed by the configuration of
switch parameters, the team parameters, and the conditions of the event. Together the
steps are called the action path. The action path displayed in this table is created on the fly
based on the present conditions during each event.
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Figure 32. The IntelliTeam SG>Activity Monitoring>Action Path screen.

The screen shown in Figure 32 reports the actions taken during execution of a team
member operation. S&C Electric Company uses this information for diagnostic purposes.

Backing out of an action path may occur when one of the steps cannot be performed.
This will require that the team member be returned to its normal state.

The following information is reported for the action path:

Direction

This is the direction the action path is presently taking. Reversing the action path will only
occur if the forward path is stopped before completion.

Action Item Pointer

This is the record within the action path that is presently being executed. S&C Electric
Company uses this information for diagnostic purposes.

Time or Reverse Time
This is the time stamp of the action.
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Forward Action / Reverse Action

This is the name of the step to be taken during execution of the action path and the time
stamp at the start of that step. Step names that may be displayed include:

e Action path done

e (lose for xfer

e Contract request

e Contract terminate
e Block recloser

e  Unblock recloser

e Block ground trip

e Unblock ground trip
e Alternate settings

e Normal settings

e Status

Status

This is the status of the associated step in the action path and the relative time at which
this step occurred. The status can be reported as: Idle, Running, Failed, or Success.
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Figure 33. The IntelliTeam SG>Activity Monitoring>Coach Activity screen.

The screen shown in Figure 33 has time stamps for basic coach activities and the counter
for each team’s coach. It includes the following information:

Number
This is the coach/team number.

In-Out Status
This is the coach activity signing in or going to the specified team member (Rec 1,
Rec 2, etc.).

Time Stamp

This is the date and time when the activity occurred.

Sign-In Counts

This is the ongoing count for each team’s coach.
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Figure 34. The IntelliTeam SG>Activity Monitoring>Feeder Nets screen.

The screen shown in Figure 34 contains data associated with the Feeder Netlists. The
following parameters are displayed:

Feeder Category

The FeederNet is a database of the teams and controls that use the same breaker at a
substation (or equivalent source) as their primary power source. These categories may be
displayed:

Primary 1—Every switch has a Primary 1 FeederNet associated with its primary substa-
tion breaker.

Primary 2—Only a tie-point control will have a Primary 2 FeederNet associated with the
adjacent substation breaker for this tie point.

Adjacent—This is the FeederNet on the other side of the tie point. These are listed for
every tie point on the primary feeder. There will generally be as many adjacent FeederNets
listed as there are alternate sources for the primary feeder.

FeederNet ID

This is the unique identifier assigned by the IntelliTeam® Designer system that defines a
specific substation breaker (or equivalent) and the circuit it supplies out to the end loads
and/or open tie points.

FeederNet CRC

This is the cyclic redundancy check (CRC), a value calculated for a specific FeederNet
configuration. The CRC changes when any FeederNet data are changed. It is used to
identify a specific FeederNet configuration version.

Clear FeederNet Button

This command clears the stored FeederNet data. When cleared, a new FeederNet list must
be pushed.
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Figure 35. The Logs>Log Management screen.

The screen shown in Figure 35 is used to configure the filter settings for viewing log
screens. The Administrative login is required to execute any of the log-control functions.
The following parameters are shown:

Logging Settings

Logging Level

The logging level selected determines the type of data-log messages captured in the base
memory module (for an IntelliRupter fault interrupter) and is displayed on the Logs>His-
toric Log screen. Every data-log message is assigned a specific log level:

Normal—User information
Extended—User information and internal status
All—User information, internal status, and internal trace/debugging information

Duplicate Event Margin (milliseconds)
Storing identical events in a short time period can flood internal memory and does not

provide useful diagnostic information. By configuring the time between duplicate-event log

entries, this setpoint determines which data will be stored in the internal memory and be
displayed on the Logs>Historic Log screen. It has no effect on an alternating sequence of
events.
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Two events are considered duplicates when every element of their event records
match, such as when the Duplicate Event Margin setting is 10 ms. and the sequence
of events ABABAB (where A and B are different) has every event occur 1 ms after the
previous one. The identical events occur within 2 ms, well within the value of the set point,
but all events will be logged because events are alternating. (Range = 0-30, increment = 1.)

Stop Historic Logging if Full

This setting stops logging events when the Historic log is full and subsequent events are
discarded without overwriting contents of the log. Flash memory logging and the Status
Point Log and Special Events counter logging are not affected by this setpoint. This
setting factory set to the No setting to ensure continued event logging.

Compact Flash Logging

When enabled, every historic event generated is written to flash memory. Logging Level
and Duplicate Event Margin setpoints do not prevent an event from being written to
flash memory. Flash memory logging preserves as much data as possible. Flash memory
data can be retrieved with IntelliLink Setup Software. Open the Tools option on the menu
bar and click on the Compact Flash Access option. Select and save any files needed. S&C
strongly recommends enabling the Compact Flash Logging setting to simplify diagnostic
and troubleshooting work.

Event Categories

Select the categories that will be displayed on the Logs>Historic Log screen. To display
only the most important operation information, select the EVT category and click the
Refresh View button. Utility operation data will be displayed and log information for
software troubleshooting and debugging will be omitted.

Logging Control

Complete data are stored in the Historic log in flash memory. Flash memory files can

be downloaded by opening the File option on the menu bar and clicking on the Flash
Memory Files option. The complete Historic log (up to a million events) cannot be viewed
through IntelliLink software, but a small subset of the Historic log (160 events) is displayed
on the Logs>Historic Log screen. Event filters can be applied to the Logs>Historic Log
screen, but these filters do not affect entry of events in the Historic Event Log.

Clear View

This button clears all data on the Logs>Historic Log screen. In Real-Time View mode, the
next qualifying event will be placed at the top of the Logs>Historic Log screen. In Static
View mode, the Logs>Historic Log screen will remain empty until it is completely refilled.

Refresh View

This button clears the present contents of the Logs>Historic Log screen and loads up 160
events from the Historic log in ascending chronological order. Only events satisfying the
checked Event Categories options are displayed on the Logs>Historic Log screen.
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Real Time View or Static View

Use this drop-down menu to select the view mode. Real Time View mode loads the latest
data on the screen, and Static View mode freezes data on the Logs>Historic Log screen.

Historic Logging
Running—Starts the Historic log but does not affect flash memory logging, Status Point
Log entries, or Special Events logging.

Stopped—This setting stops the Historic log but does not affect flash memory logging,
Status Point Log entries, or Special Events logging. Subsequent events will not be put into
the Historic log, preventing newer events from overwriting older events. Be sure to return
the Historic Logging mode to the Running setting so future events will be logged.

Clear History Log

This button clears all data in the Historic log. It does not affect flash memory logging,
Status Point log entries, or Special Events logging. The date and time of the last Clear
History Log command are displayed. Clearing the Historic log permanently deletes all
event data. If needing to preserve event data, generate an HTML report of logged data
before clearing the log.

Chronological Browsing (static — no refill)

Chronological browsing is only available in the Static View mode. It is not available in the
Real Time View mode. Because the size of the Logs>Historic Log screen is only a fraction
of that of the Historic log, the Historic log must be navigated chronologically, either in
Browse By Time mode or Browse By Page mode.

Browse By Time

This loads up to 160 events that occurred at or after the specific time entered. Only events
that satisfy the event categories criterion are placed in the Logs>Historic Log screen. If all
events in the Historic log occurred before the specified time, the oldest-available events
are placed in the Logs>Historic Log screen. The Logs>Historic Log screen is refilled

as soon as the specific time is entered; the specified time is cleared when the refill is
complete.

Browse By Page
Historic Log pages can be browsed four ways:

Oldest 8 Pages—Loads up to 160 of the oldest-qualifying events from the Historic
Event Log

Newest 8 Pages—Loads up to 160 of the newest-qualifying events from the Historic
Event Log

Previous 8 Pages—Loads up to 160 previous events relative to the events currently in the
Logs>Historic Log screen

Next 8 Pages—Loads up to 160 next events relative to the events currently in the
Logs>Historic Log screen

S&C Instruction Sheet 766-550 95



Data Logging

When the selection is entered, the Logs>Historic Log screen is refilled immediately.
Because the Historic log is circular, selecting the Previous 8 Pages option may cause the
newest events to be displayed (if the Logs>Historic Log screen presently holds the oldest).
Similarly, selecting the Next 8 Pages option may cause the oldest events to be displayed
(if the Logs>Historic Log screen presently holds the newest).

Waveform Capture
Manual Commands Trigger a Waveform Capture
e C(Click on the Wave Form Capture button

e Issue the SCADA Execute Waveform Capture command

Automatic Actions Trigger a Waveform Capture
e Any Open, Close, or Trip event

e Any protection element enters a timing state

e  When a protection element is still timing additional waveform captures are triggered
to record the entire event

o A test using PulseClosing Technology starts (Additional wave form captures are not
triggered during the PulseTest sequence.)

Protection Elements Trigger a Waveform Capture
e Overcurrent elements

e Definite Time, Current Supervised Under Voltage element (used for
sectionalizing)

e Definite Time Under/Over Voltage element
o Definite Time Under/Over Frequency element
e Ground Trip Delay element

o Negative Sequence Trip Delay element

Abnormal Change of State Triggers a Waveform Capture
e Pole errors

e Loss of power

e IMS Low Charge Rate alarm
e IPM Charge Disabled alarm

o Leakage Current Check error
e Leakage current survey (test)

The waveform captures are stored in compact flash memory. Select the Tools>
Compact Flash Access menu options to retrieve the file.
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Figure 36. The Logs>Historic Log screen.

The screen shown in Figure 36 displays the Historic log, a subset of the Historic Event
log. It is a chronological listing of events filtered based on the criteria specified on the
Logs>Log Management screen. In Real-Time View mode, when the log is full each new
event overwrites the oldest event in the log.

The Historic log does not show the entire Historic log, which is stored in flash
memory. Flash memory files can be downloaded by opening the Tools option on the
menu bar and clicking on the Compact Flash Access... option. Select and save any files
needed. The following parameters are shown:

Clear View

This button empties the Historic log. In Real Time View mode, the next qualifying event
will be placed at the top of the log. In Static View mode, the log will remain empty until it
is refilled.

Event Description
This field provides the description for each event.

Category
Each historic event is assigned to a category to simplify filtering and sorting.

Time Stamp

The date and time of the event occurrence based on the Time Source Synchronization
setting on the Setup>General>Time screen.

Data 1, Data 2, Data 3, Data 4

Each event message, in conjunction with the Data 1 through Data 4 code, describes the
event and action(s) taken. S&C Electric Company uses any value(s) in the other data
columns for diagnostic purposes if an event message refers only to Data 1.
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Figure 37. The Logs>Status Point Log screen.

The screen shown in Figure 37 indicates whether a status point is active or inactive,
how many times it has been active, when it last became active, and when it last became
inactive. Two Historic events are associated with each status point in the Historic log—
when the status point became active and when it became inactive.

For example, if a status point has been active 100 times and is active now, 199 related
events are included in the Historic log—100 for the status point becoming active, and
99 for the status point becoming inactive. The Logs>Status Point Log screen is a conve-

nience; this information is also available in the Historic log.

Reset Current Count

This button resets the current count column of the table displayed on the screen.

Last Reset Time
This is the date and time the current count total was reset.

Status Description

The definition of each status point is available in S&C Instruction Sheet 766-560, “IntelliR-
upter® PulseCloser® Fault Interrupter: DNP Points List and Implementation.”
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Status

This shows the state of the status point: a red dot indicates active, and a gray dot indicates
inactive.

Total Count
This is the total number of times the status point has been active.

Current Count

This is the number of times the status point has been active after a Reset Current Count
button command.

Time Active

This is the date and time the status point last became active after a Reset Current Count
button command.

Time Cleared

This is the date and time the status point last became inactive because the status point
counters were reset.
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Figure 38. The Logs>Special Events screen.

The screen shown in Figure 38 shows Special events. Some Historic events are Special
events, such as when a flash memory failure will adversely impact operation. This screen
indicates how many times each special event has occurred, the last time it occurred, and
the last time it cleared. The following parameters are shown:

Reset Current Count
This button resets the current count column of the table displayed on the screen.

Last Reset Time
Date and time the current count totals were reset.

Event Description

See S&C Instruction Sheet 766-561, “IntelliRupter® PulseCloser® Fault Interrupter: Data
Log Messages” for the definition of each event.

Total Count
This is the total number of times the special event has occurred.

Current Count

This is the number of times the special event has occurred since the last reset using the
Reset Current Count button on this screen.

Last Time Active

This is the date and time the special event last became active since the current count
was reset.

First Time Active

This is the date and time the special event first became active since the current count
was reset.
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Figure 39. The Logs>Startup History screen.

The screen shown in Figure 39 displays system start and stop time stamps, in ascending
order. The following parameters are shown:

System Down Time
This is the date and time power to the control was lost.

System Up Time

This is the date and time power to the control was restored.

When Compact Flash Logging mode is enabled (from the Logs>Log Management
screen), every historic event generated by the IntelliRupter fault interrupter is written to
flash memory, even if historic event logging has been stopped for the Historic log or the
event does not satisfy logging criteria.

Only the IntelliNode™ Interface Module has a removable compact flash memory card.
The 6800 Series Automatic Switch Controls, the 6801M Automatic Switch Operators, and
the IntelliRupter PulseCloser Fault Interrupters use flash memory that cannot be removed.
However, the screens and descriptions refer to the permanent flash memory as “compact
flash” memory.

The IntelliRupter fault interrupter uses 100 pre-allocated fixed-size files to store
historic event data in the compact flash memory and stores over 1,000,000 events. The
files are named LOG00.VM, LOG01.VM...LOG98.VM, LOG99.VM, and are all a very similar
size. Files are continuously reused. When data logging fills all 100 files, LOG00.VM will be
opened again, and new events written, starting at the beginning of the file and replacing the
oldest events. This means that after all 100 files have been used, at any given moment, one
of the files is circular, without a fixed beginning.
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Viewing Compact
Flash Data

Note: The number of event entries in a full file is about 10,000, but this is not a precise
count and varies slightly for each file. This means that a reused file is likely to contain

a small amount of very old data at the end. The older events are identified by their time
stamp. Sometimes data being stored to a file are interrupted, usually by a power loss or
Compact Flash card removal. In this case, data logging assumes that the file is corrupted,
saves it under a unique name such as “AABBCCDD.err”, and creates a new file for future
use. A corrupted file like this can still be useful because usually only a small amount of
data has been corrupted.

The Compact Flash Memory logs cannot be viewed using IntelliLink software; they must
be downloaded to a computer. See Figure 40.
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Figure 40. The Compact Flash Access dialog box.
Follow these steps to download the log files:

STEP 1. In the Tools pull-down menu, select the Compact Flash Access... option to
open the Compact Flash Access dialog box.

STEP 2. Inthe “Local File System” section of the screen, select the target directory for
the file download.

STEP 3. In the “Remote File System” section of the screen, select the HISTLOG folder.
STEP 4. Select the file to download.
STEP 5. Right click the selected file and select the Download option.

The download progress will display in the lower right corner of the Compact Flash
Explorer dialog box. Wait until the download has completed and navigate to the down-
loaded file to view it. An .xml and an .html version of the file will be created in the target
directory.
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To view waveform capture files, first install WaveWin software on the computer. See
S&C Instruction Sheet 766-571, “IntelliRupter® PulseCloser® Fault Interrupter:
Software Installation,” for software-installation instructions.

When troubleshooting events, first download Waveform Capture files and Historic
log files. Click on the modification time header to have the files sort according to the
modification date, and select the files in the date range of the event to be analyzed.

Always save a Snapshot file for the Main IntelliLink File menu and download
the Waveform Capture and Historic Log files related to an event when contacting S&C.
If there is a mechanism issue, also include the MECH files beginning from the time the
issue began.
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Connection
Problems

Contacting S&C

This section provides guidance for troubleshooting connection problems after installing
LinkStart Version 3 Wi-Fi interfacing software for IntelliRupter fault interrupters. The
troubleshooting steps can also be used as an installation checklist for identifying potential
problems, or conflicting software, on the user’s computer.

These instructions are generally applicable to other S&C automation controls with
Wi-Fi capability.

Connection problems fall into the following general categories:

o The software fails to connect with the desired unit, and no signal strength is shown in
the LinkStart Connection screen.

e The signal strength is shown temporarily, but the connection process does not
complete.

o The connection process completes, but the connection cannot be maintained
reliably, or cannot be maintained at all.

o The Wi-Fi connection is reliable, but IntelliLink Setup Software or DU.exe will not
successfully connect.

o The Wi-Fi connection is successful, but the connection is lost after a control
firmware download.

Unfortunately, there are numerous problems that can manifest themselves in different
symptom categories, so diagnosis of any problem should consist of following the complete
checklist from beginning to end. It is strongly advised going through the entire checklist
before contacting S&C Electric Company.

This document focuses almost entirely on the software environment of a computer
intended to access an IntelliRupter fault interrupter. This is not a troubleshooting guide for
IntelliRupter fault interrupter firmware.

Installation of software and drivers requires administrative privileges on the computer.
It is very advantageous to have access to the Internet so replacements for obsolete drivers
or other software can be obtained if necessary.

Confirm that the S&C device is energized. The STATUS lamp on the IntelliRupter
fault interrupter will blink once every 30 seconds when it is energized and
operational.

If troubleshooting does not resolve the problem, generate a Microsoft System Information
report on the computer and contact the S&C Global Support and Monitoring Center by
following this procedure:

STEP 1. Run the program: C:\Program Files\Common Files\Microsoft Shared\MSInfo\
msinfo32.exe.

STEP 2. On the File menu, click on the “Save” entry.
STEP 3. Zip the output file and email it to: GSMC@sandc.com.
STEP 4. Call the S&C Global Support and Monitoring Center at (888) 762-1100.
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Wi-Fi
Troubleshooting
Procedure

If a conflict is discovered between the settings specifications, software/driver versions,
or other requirements listed in this guide and the target computer, the conflict should be
resolved and the computer rebooted before continuing the troubleshooting

procedure.

The following steps are used for Wi-Fi connection problems:

STEP 1.

STEP 2.

STEP 3.

STEP 4.

STEP 5.

Go to the Add/Remove Programs menu entry, and check whether LinkStart
v2 or v3 is installed. Version v2 and/or v3 must be uninstalled before installing
LinkStart v4. If version v2, or versions v2 and v3, are installed, remove both and
reinstall LinkStart version v4 only.

Make sure the driver for the Wi-Fi interface on the computer is up to date. Be
particularly sensitive to Intel 3945 and 4935 Wi-Fi interfaces because older
versions of the drivers for these interfaces have known problems.

Check the computer manufacturer’s website for up-to-date drivers. If the
updates are not there, contact the manufacturer of the hardware interface.

The Intel AC 8260 Wi-Fi Adapter and the Intel Dual Band Wireless-AC 7260
require the latest driver. If issues are observed with these adapters, update to the
latest driver.

Any Wi-Fi-specific PC software such as connection managers, with the exception
of the Windows Zero Configuration Service (WZC), will likely cause problems
with LinkStart connection establishment and reliability. Disabling these
managers is usually enough to resolve any problems, but sometimes it is neces-
sary to uninstall them.

Note also any computer software that is Wi-Fi sensitive or specific in
any way will likely cause a potential conflict. The typical conflicts that occur
are with:

(a) Intel PROSet—If it is active, open its Interface screen and disable it by
selecting the Let WZC manage the connection option.

(b) AT&T Cellular Interface—Configure it so it does not attempt to manage the
Wi-Fi connection.

(c) AT&T Airport Connection Software Boingo Wireless

(d) Cisco AnyConnect VPN Client

Check both firewall and antivirus software. Make sure both the firewall and
antivirus software have either been configured to allow LinkStart and the related
S&C applications to operate (see the “Symantec Endpoint Protection” section
on page 109 for the list of exclusions to configure), or disable both the antivirus
and firewall software, at least for testing purposes.

Certain programs such as “Symantec Endpoint Protection” will automati-
cally re-enable certain features after a brief time. To be sure these features are
disabled during testing, first enable the software and then immediately disable it.
Make Wi-Fi operational on the computer.

(a) Set the Wi-Fi adapter power setting to the Maximum Performance setting.
(b) Turn off Airplane mode.
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STEP 6.

STEP 7.

STEP 8.

STEP 9.

STEP 10.

STEP 11.
STEP 12.

STEP 13.

STEP 14.

STEP 15.

(¢) Turn on the manual Wi-Fi switch, if present. Many wireless-equipped laptop
computers have a slide switch to enable Wi-Fi operation, while others use a
combination of key strokes to enable/disable the Wi-Fi adapter. Because the
Wi-Fi device driver may not know the state of the on-off control, make sure
to know how to turn on Wi-Fi operation.

Start the LinkStart software. Verify the LinkStart software is using the correct
Wi-Fi adapter, and attempt to connect to the desired IntelliRupter fault
interrupter.

Verify the IntelliRupter fault interrupter being connect to has power and the
correct IntelliRupter fault interrupter serial number displays in the serial number
field on the LinkStart screen.

When unable to connect, attempt a connection using the Universal Serial
Number 00-0000000.

If the laptop will not connect even to the Universal Serial Number, confirm the
Wi-Fi antenna is connected internally. Remove the large, outer bolts from the
panel holding the Wi-Fi antenna in place and confirm the antenna lead remains
connected to the external antenna.

If the lead is connected and Wi-Fi is still not functional, replace the communica-
tion module with known good module.

If Wi-Fi is restored, issue an RMA for the original communication module.

If a signal strength indication can’t be seen, verify the Wi-Fi adapter is turned on.
See Step 5 on page 105.

If there is signal strength and the connection process has completed, select Intel-
liLink software. If the IntelliLink software does not connect (no Logon screen
appears), verify both virtual LEDs on the LinkStart software screen are green.

If they are not (right side LED is red) but there is still a connection, swap or
reinsert first the communication module and then the control module to isolate
the problem.

If both LEDs are green, then there should be a logon prompt that enables a log
in. If not, then there is probably a problem with conflicting Wi-Fi management
or with antivirus or firewall software on the computer. Contact the S&C Global
Support and Monitoring Center for help with Wi-Fi connection troubleshooting.

LinkStart cannot connect to an IntelliRupter fault interrupter docking station.

(a) Confirm the Wi-Fi jumper has been installed on the docking station.

(b) If the Omicron Test Set is being used with the control module, remove the
Omicron Test Set, reinstall the control module, and start the LinkStart
software again.

Note: LinkStart software generates logs to aid with troubleshooting. They can be found at:
C:\Users\Public\Documents\S&C Electric\LinkStart. Be sure to include the latest logs when
contacting the S&C Global Support and Monitoring Center for support.
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IP Addresses

LinkStart Port Use

Wi-Fi Module
The Wi-Fi module has a fixed IP address of 192.168.101.1.

LinkStart

LinkStart acquires a random IP address on the 192.168.101.0/24 subnet in the range
192.168.101.2 to 192.168.101.254 on the 802.11 network adapter.

For some operations it binds to the local host loopback IP address of 127.0.0.1.

Note: Windows 10 may not provide a usable IP address. The command “ipconfig” can

be run from the command prompt to determine whether an appropriate IP address was
obtained. If not, troubleshooting tips can be found at this link: www.sysprobs.com/fixed-
windows-10-limited connectivity-not-getting-ip-from dhcp.

Tables 6 and 7 show the ports used by LinkStart software but do not include dynamically
assigned ports (IPPORT_ANY) assigned by the system when LinkStart connects to well-
known ports on the Wi-Fi module.

Table 6. LinkStart Port Use on the 802.11 Adapter interface (192.168.101.2 to
192.168.101.254)

Port Protocol Comment

V3 Message Protocol. Receive Wi-Fi module responses to messages
1006 UDP/In initiated by the LinkStart software
1007 UDP/In V3 Message Protocol. Receive messages initiated by the Wi-Fi module
1008 UDP/In V3 Detailed Logging
1021 UDP/In Receive KeepAlive from the Wi-Fi module

Table 7. LinkStart Port Use on the Local Host Loopback IP Interface (for RO
communication modules, use 127.0.0.1; for R3 communication modules, use
192.168.101.1)

Port Protocol Comment

20000 UDP UDP COM Bridge: LinkStart software to IntelliRupter fault interrupter
20001 UDP UDP COM Bridge: IntelliRupter software to LinkStart

9797 UDP SDA-4554R3-xxx (R3) communication module
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Wi-Fi Module Table 8 shows the ports used by the Wi-Fi module:
Port Use Table 8. SDA-4540-xxx Wi-Fi Module Port Use
Port Protocol Comment
116 TCP V3 file upload
1002 UDP UDP COM Bridge, LinkStart to Wi-Fi module
1006 UDP V3 message protocol. Messages initiated by LinkStart
1007 UDP V3 message protocol. Messages initiated by Wi-Fi module
1008 TCP V3 file download
1020 UDP KeepAlive
8828 TCP VCOM router (e.g., RadioShop...)
8888 TCP RSA authentication

Table 9 shows the default ports used by the SDA-4540R3-xxx communication module
Wi-Fi module (These are user-configurable with a range of 1024 to 65535.):

Table 9. SDA-4540R3-xxx Wi-Fi Module Port Use

Port Protocol Comment

9797 uDP (R3) IntelliLink UDP port

8828 TCP (R3) VCOM TCP port

8829 UDP (R3) Comm Module Keep-alive port
Firewall Settings Figure 41 shows a typical firewall configuration:

(0] Allow [7* cprogram filesis&e electricUinkstartv3Vlinkstart exe
f? C:\Program Files (x86)'S&C ElectriciLinkStarty3\LinkStart exe

Local192.165.101.1-192.166.101 254
Remote:192.168.101 1

SED

& TCP.[Remote=115,116,1008 8080,8528,8858]
6 UDP:[Local=1006,1007,1008,1021; Remote=1002,1006,1007,1020)

Figure 41. This is a representation of the allowances the firewall could make.

Note: In LinkStart V4, the TCP/IP Ports are configurable. S&C recommends using the
default settings in Table 9 and shown in Figure 42.

TCP/IP Port Options

R3 IntelliLink UDP Port (1024-65535) 3797 |

R3 VCOM TCP Port (1024-65535) |8828

R3 Keepalive UDP Port (1024-65535) Iaazg

Use Defaults | oK |

Figure 42. The TCP/IP Port Options dialog box accessed through the Tools>TCP/IP Port
Options menu.
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Symantec Endpoint Symantec Endpoint Protection (SEP) clients have been configured to accommodate the
Protection LinkStart software. Tables 10 and 11 show execution policy settings:

Exclusion Policy
Table 10. Directories being Excluded from SEP Scanning

Directory Comment
%[PROGRAM_FILES]%S&C Electric Security Risk Folder—Ignore

c:\Documents and Settings\All Users\
Application Data\S&C Electric

Security Risk Folder—Ignore

c:\Documents and Settings\All Users\
Documents\S&C Electric

%[PROGRAM_FILES]%S&C Electric Tamper Protection File—Ignore

c:\Documents and Settings\All Users\
Application Data\S&C Electric

Security Risk Folder—Ignore

Tamper Protection File—Ignore

c:\Documents and Settings\All Users\Documents\S&C

Electric Tamper Protection File—Ignore

Table 11. Another Way of Specifying the Exclusion Policy Paths

Directory Comment
%[PROGRAM_FILES]%S&C Electric Security Risk Folder—Ignore
%[ALLUSERSPROFILE]%Application Data\S&C Electric Security Risk Folder—Ignore
%[ALLUSER%ZECIJEITGI}I(_:FA:’:/QDocuments\ Security Risk Folder—Ignore
%[PROGRAM_FILES]%S&C Electric Tamper Protection File—Ignore
%[ALLUSERSPROFILE]%Application Data\S&C Electric Tamper Protection File—Ignore
%[ALLUSER%ZEOEILII(_:E%Z/ODocuments\ Tamper Protection File—Ignore

Firewall Policy

The firewall policy has been modified to allow LinkStart communication. This applies
only to laptop computers; desktop computers do not have an SEP Firewall installed.
The firewall modifications noted in Table 12 and Tables 13 through 15 on page 110 are
required for LinkStart communication:

Table 12. IP Range:192.168.101.1 to 192.168.101.254 for
Any Application (could be limited to LinkStart.exe)

Port Protocol Action
1006 UDP/In Allow
1007 UDP/In Allow
1008 UDP/In Allow
1021 UDP/In Allow
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Table 13. SDA-4540-xxx IP 127.0.0.1 for Any Application

Port Protocol Action
20000 UDP Allow
20001 UDP Allow

Table 14 shows the default ports. (These are user-configurable with a range of 1024 to
65535. If the defaults are changed, the configured ports must be allowed.)

Table 14. SDA-4540R3-xxx IP 192.168.101.1 for Any Application

Port Protocol Action
9797 UDP Allow
8828 TCP Allow
8829 UDP Allow

Table 15. Ports that Must also be Allowed for
Other Applications and Any IP Address

Port Protocol
116 TCP
1002 UDP
1006 UDP
1007 UDP
1008 TCP
1020 UDP
8828 TCP
8888 TCP
8829 UDP

Verify these exceptions have been pushed to the clients.
Check the registry under this registry path:

HKEY_LOCAL_MACHINE>SOFTWARE>Symantec>Symantec Endpoint Protection>AV>-
Exclusions>ScanningEngines\

Several keys in this registry show exceptions pushed to clients.
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Windows Defender Windows Defender antivirus users must add the Linkstart and IntelliLink software
Antivirus programs to the Allowed Apps list. Follow these steps to add the programs:

STEP 1. In the Windows search window, type “fire.” See Figure 43. Click on “Firewall &
network protection.”

All Apps Documents Web More ¥

Best match

E FileZilla

App

‘ Windows Defender Firewall
Control panel

Apps

& Windows Defender Firewall with
Advanced Security

Settings

¥ Firewall & network protection >

& Check firewall status >

@ Allow an app through Windows
Firewall

% Find and fix problems with Windows
Firewall

b4

¥ Windows Security >

Search work and web

L fird

Figure 43. The Windows search dialog box.
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STEP 2. Select “Allow an app through firewall.” Administrative privilege is required. See
Figure 44.

Windows Security = o *

) Firewall & network protection

Who and what can access your networks, Windows Community videos
ﬁ bout Firewall & network
o) Bo Domain network
fe3 G i on Have a question?
| o Get help
= @ Private network (active)

Firewall is on, Who's protecting me?

Manage providers

a
2 3 Public network (active)
& Firewall is on, Help improve Windows Security

Give us feedback

Allow an app through fi

Change your privacy settings

View and change privacy settings
for your Windows 10 device,

Figure 44. The Firewall & network protection screen.

STEP 3. Scroll through the “Allowed apps and features:” list and check the applications
in the public profile. See Figure 45 on pagel13 and Figure 46 on page 113.
Table 16 lists the applications that must be allowed and their file locations.

Table 16. Applications That Must Be Allowed

Application File Location
llinké C:\Program Files (x86)\S&C Electric\IntelliLink6\iLink6.exe
S&C Communication | C:\Program Files (x86)\S&C Electric\IntelliLink6\CpsServer.exe, C:\Program Files
Server Console (x86)\S&C Electric\IntelliLink6\CpsConsole.exe
LinkStart.exe C:\Program Files (x86)\S&C Electric\LinkStartV4\LinkStart.exe
S:trilgr? VCo Appli- C:\Program Files (x86)\S&C Electric\LinkStartV4\SandCVCom\SandCVComCfg.exe
ggﬁi(l:\l:twork C:\Program Files (x86)\S&C Electric\LinkStartV4\ SandCNetSvc.exe

STEP 4. Click on the Change Settings button.
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Mame

Allowed apps and features:

Demain  Private  Public  Group Pelicy *

[ Remote Event Log Management (] O | Ne
[ Remate Event Monitor (] a a Mo
[J Remaote Scheduled Tasks Managenment O O a Mo
[ Remote Service Management (] O O Mo
[ Remaote Shutdown (] (| O Mo
[ Remate Valume Management (| O O Mo
[ Reuting and Remate Access 0O O O Mo
b 5B Cemmunication Server Consale | %] 5] | M
[ SB.C Metwork Service M =) Ma
b7 SandCVCo Application W [ [ Mo

W] Secure Socket Tunneling Protocol O -
B Sentinel License Manager B = (| N i

Details... Remove

Figure 45. The Allow apps to communicate through Windows Defender Firewall dialog box.

Allowed apps and feabures:

Mame Domain  Prvate  Public  Group Policy ™

[ File and Printer Sharing ever SMBDinect O O O No

B Google Chrome = No

B Hive Streaming =B = = No

[ HemeGrou 5 g [] No
Fr— R T

Oi5CS Service O o O No

O Key Management Serace O [m] O e

B LinkStart.exe = = E Ne |

& mDNS = = No

O Media Center Extenders O a O HNe

| Microsoft Content & = = No

A Micresoft Edge =] =] = No -

Dl Rermaice

Figure 46. The Allow apps to communicate through Windows Defender Firewall dialog box

continued.
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